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1 ProSoft Wireless Designer 

In This Chapter 

 Purpose of this Guide..............................................................................8 

 How to Get Help ......................................................................................8 

 Functional Specifications.........................................................................9 

 System Requirements .............................................................................9 

 Installation .............................................................................................10 

ProSoft Wireless Designer is an application (computer program) that simplifies 
the task of designing your ProSoft Wireless network, and specifying the 
components for your installation.  

ProSoft Wireless Designer is a fast, accurate way to develop a comprehensive 
specification list and Bill of Materials for your wireless network. Use ProSoft 
Wireless Designer to specify: 
 Radios 
 Cables 
 Lightning Protection 
 Connectors 
 Antennas 

ProSoft Wireless Designer simplifies the task of planning and specifying your 
ProSoft Wireless network. The easy to use, wizard-based interface creates a 
visual layout of your radios and sites, and generates a complete Bill of Materials 
including radios and accessories. 

Updates 
You can always find the latest version of ProSoft Wireless Designer from the 
ProSoft web site at www.prosoft-technology.com 

ProSoft Technical Support strongly recommends keeping your computer updated 
with the current Windows service packs and hot fixes. Go to 
http://windowsupdate.microsoft.com (http://windowsupdate.microsoft.com) to 
download and install the latest updates for your Windows operating system.  

Where to Find the Manuals 
For help configuring a specific module, refer to the online manuals 
(documentation) for your module. You can find the manuals on the CD-ROM 
supplied with your module, or you can download them from the ProSoft web site 
at www.prosoft-technology.com. 

http://windowsupdate.microsoft.com/
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ProSoft Wireless Designer Online Help 
ProSoft Wireless Designer comes with an extensive online help system that 
explains in detail how to use the program. If you have used other Windows 
applications, you may already be familiar with using online help systems. If online 
help is new to you, or you would like to refresh your memory, refer to Basic 
Principles (page 79) for "how-to" information on Windows help.  

1.1 Purpose of this Guide 

The ProSoft Wireless Designer is designed to assist those involved in designing, 
planning, and installing industrial wireless networks. 

Given the complexity of industrial data communications, this guide takes the 
reader step-by-step through the process of: 
 Understanding Wireless Communications 
 Designing Wireless Networks 
 Performing Path Studies and Site Survey Procedures 
 Selecting modems, antennas, and cables 
 Maintaining and troubleshooting wireless networks 
 Generating a Parts List to simplify ordering all the necessary components 

The last section of this guide contains complete specifications for RadioLinx 
Wireless Modems, ProLinx Wireless Gateways, InRAx/ProTalk Wireless PLC 
modules, antennas, cables, and other wireless accessories. 

ProSoft Technology’s Wireless Support Team is available to assist with wireless 
network design, path studies, and product selection. ProSoft Technology offers 
Site Survey services (call for a price quote) and will lend wireless products for 
testing. 

1.2 How to Get Help 

ProSoft Technology has several ways for customers to acquire knowledge fast! 
In an all encompassing support page, technical support is now right at your 
fingertips. Here you get the ProSoft Knowledgebase, a community of experts and 
experienced end-users on our bulletin board, as well as presentations, one-on-
one chat, on the go tutorials and streaming media training. 

Knowledgebase: Type a question into our knowledgebase search engine. 
Answers come from a technical support knowledge database built from helping 
inquisitive customers like you. 

Frequently Asked Questions: If you want to know ProSoft Support’s top ten 
questions asked, just click on our FAQ. Using an FAQ could get you the answers 
you need immediately. Check back regularly for updates. 

Bulletin Board: Here’s a public forum just for you. Make comments, ask 
questions, and get to know ProSoft’s automation community. Register, login, and 
join the discussion. 
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Live Chat (8am to 5pm PST): Communicate with a Technical Support Engineer 
online. This is just one more way to get one-on-one support from our 
knowledgeable support staff. 

Downloads: Look no further. Get manuals, datasheets, configuration utilities, 
and more. 

Training: Get help through our online tutorials and streaming media training 
series. 

Contact: You can always call or email with your technical support questions. 
Also, if you have any comments or suggestions, please let us know. 

Go to www.prosoft-technology.com/support (http://www.prosoft-
technology.com/support) or call +1.661.716.5100 

1.3 Functional Specifications 

 Contains a database of all currently available RadioLinx radios, antennas, 
cables, connectors and accessories 

 Exports Parts List, Site and Link Details, and Wizard settings into a variety of 
common file formats, for import into applications such as spreadsheets, 
databases and word processors 

 Checks wireless link feasibility based on path length and recommended 
accessories 

 Predicts signal strength based on distance, local regulations and hardware 
choices  

 Fully documents your ProSoft Wireless network plan 

1.4 System Requirements 

ProSoft Wireless Designer is designed for computers running Microsoft Windows 
and Microsoft .NET Framework version 2.0 or newer. 

Minimum hardware requirements are: 
 400 MHz or faster Pentium PC  
 128 MB RAM 
 CD-ROM drive 
 280 MB available hard drive space 

The Microsoft .NET Framework version 2.0 is not supported on Windows 95 or 
Windows NT 4, or Windows 3.x.  

It is highly recommended for all platforms that you upgrade to the latest Windows 
Service Pack and critical updates available from http://www.windowsupdate.com 
to ensure the best compatibility and security. 

http://www.prosoft-technology.com/support
http://www.prosoft-technology.com/support
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1.5 Installation 

Installation is straightforward if you follow these steps: 

To install ProSoft Wireless Designer: 
1 Verify that your computer meets the hardware and operating system 

requirements.  

Important: You must have "Administrator" rights on your computer to install this application. 
Important: Please open and read the release notes on the CD before starting the installation. The 
release notes are located in the root directory of the CD-ROM. 

2 Insert the ProSoft Wireless Designer CD-ROM in an available CD-ROM drive 
in your computer. 

3 On most computers, the installation program will start automatically within a 
few seconds. If the installation does not start automatically on your computer, 
click the Start button, choose Run, and then type explorer. Click OK to start 
Windows Explorer. In Windows Explorer, open the My Computer icon and 
navigate to the CD-ROM drive. Double-click the file "Setup.exe". This action 
starts the installation wizard. 

4 Follow the instructions on the installation wizard to install the program. 
5 Click Finish to complete the installation. If you are prompted to restart your 

computer, save your work in any applications that are running, close the 
applications, and allow the computer to restart. 
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2 Using ProSoft Wireless Designer 

In This Chapter 

 Starting ProSoft Wireless Designer .......................................................11 

 Setting Application Preferences ............................................................12 

 About the Sample Application ...............................................................13 

 Designing a New Network .....................................................................20 

 Adding a Site .........................................................................................21 

 Viewing Site Properties .........................................................................22 

 Adding a Link.........................................................................................23 

 Viewing Link Properties .........................................................................23 

 Adding Antennas ...................................................................................23 

 Adding Cables .......................................................................................24 

 Adding Lightning Protection...................................................................24 

 Modifying an Existing Network ..............................................................25 

 Saving a Network ..................................................................................25 

 Exporting Wizard Choices .....................................................................26 

 Exporting Site Details ............................................................................26 

 Exporting Link Details............................................................................27 

 Exporting a Parts List ............................................................................27 

 Printing ..................................................................................................28 

 

2.1 Starting ProSoft Wireless Designer 

To start ProSoft Wireless Designer: 
1 Click the Start button, and then choose Programs. 
2 In the Programs menu, choose ProSoft Technology. 
3 In the ProSoft Technology menu, choose ProSoft Wireless Designer 
4 To configure a new site, choose Design a New Network or Open an 

Existing Network.  

Tip: The installation program includes a sample application that you can use to familiarize yourself 
with ProSoft Wireless Designer. The file is named "Wireless Oil Network.wdd", in your ProSoft 
Wireless Designer installation folder, normally C:\Program Files\ProSoft\ProSoft 
Wireless Designer 
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2.2 Setting Application Preferences 

Use the Settings (page 36) dialog box to view or modify the following application 
settings and document for ProSoft Wireless Designer.  

Global preferences (applies to all documents) 
 Measuring Units 

Document preferences (applies to current network design only) 
The following preferences take effect for any new sites that you add to the 
current network design. Changes in this section do not apply to existing sites.  
 Network Name (enter the network name in this field) 
 Default site parts (click the button for each item to view or modify) 
 Region (choose the region or country from the dropdown list)  
 Environment (select indoor or outdoor)  
 Site Font (click the button to select font size and style) 
 Site Image Size (click the button to select small, medium or large radio icon) 
 Draw to Scale (select or clear the checkbox) 
 Show link details (select or clear the checkbox) 

2.2.1 Customizing Application Colors 

Use the Customize Application Colors (page 37) dialog box to select or 
customize the color scheme for the Network Details, Diagram and Parts views.  

To customize application colors: 
1 Open the View menu, and then choose Customize Colors. 
2 On the Customize Application Colors dialog box, choose a color scheme from 

the dropdown list, or create your own color scheme. 
3 To create a customized color scheme, click the button for an item (for 

example, Background, Cell color, and so on). 
4 On the color dialog box, click to select a basic color, or use the custom colors 

palette to create a color. 
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2.3 About the Sample Application 

ProSoft has provided a sample application consisting of a variety of sites, relays 
and devices, to show how a wireless network might be designed.  

To open the sample application 
1 Open the File menu, and then choose Open. 
2 In the Open Document dialog box, choose Wireless Oil Network.wdd, and 

then click Open. 

The sample application describes a network that connects the Headquarters site 
through a series of relay points, to a remote office ten miles away, and then to a 
pair of pumps approximately two miles from the remote office. 

The following illustration shows the Diagram view, with each site (radio) and its 
link relationship to the next site.  
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In the Diagram view, you can double-click a site (radio) or a link, and view or 
modify the properties. The following illustration shows the properties for the 
Office site. 

 

Click on any of the icons or buttons in this dialog box to see additional 
information, or to change your selections. The following illustration shows the 
Antenna Selection dialog box, which opens when you click the Antenna icon. 

 

On the Antenna Selection dialog box (and other dialog boxes that link from the 
Site Properties dialog box), you can use the dropdown lists or text boxes to 
change your selections.  
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Notice that when you select a different antenna type or part number (for 
example), the information in the Description fields in the dialog box is updated to 
match your new selection.  

 

The following illustrations show some of the other dialog boxes linked to the Site 
Properties dialog box. 

 

 

In some cases, changing a selection may cause conflicts with other equipment 
you have selected. For example, if you click the Radio icon, the following 
message box will open. 

 

This warning does not stop you from selecting a different radio, however you 
should understand the changes this will require for your site design.  
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When you click Yes on this message box, the Radio Selection dialog box opens. 

 

The following illustration shows the Link Properties dialog box, which opens 
when you double-click a link (the colored line joining two radios). 

 

The Link Properties dialog box shows the signal levels and link status for the link, 
based on the antenna, cable and connector types selected for the two sites, as 
well as the distance in miles or kilometers between the two radios.  

Notice that the information on this dialog box is based on the two antennas 
having a clear line of sight, without obstructions such as trees, terrain or 
structures.  
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The following illustration shows a link that attempts to cover a distance beyond 
the transmission capabilities of the radios and antennas. 

 

If the signal must negotiate a distance longer than the maximum range of the two 
radios, or if a direct line of sight is is not possible because of the physical 
features of your site, you will need to add relay points to accommodate your 
design.  

 

To add a relay point, click the right mouse button to open a shortcut menu, and 
then choose Site Tool. 
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Click the left mouse button in the Diagram area, and fill in the Enter New Site 
Data dialog box. 

 

Tip: If you enter the Latitude and Longitude coordinates for each site, ProSoft Wireless Designer 
will calculate the link distance automatically. Click the Lat/Long Coordinates button to enter the 
coordinates. 

Notice that you can enter the coordinates in a variety of ways. Select the tab that 
shows the coordinate entry format to use. In the following illustration, the decimal 
coordinates were entered from the display on a handheld GPS device placed at 
the proposed location for the site. Be sure to specify the correct North/South and 
East/West position for your coordinates.  
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The following illustrations show the Parts List, Site Details and Link Details for 
the sample application.  

 

Notice that the Site Details and Link Details tabs show details for only one site or 
link at a time. Use the Next and Previous buttons to view the rest of the sites and 
links in the sample application.  
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2.4 Designing a New Network 

ProSoft Wireless Designer uses a setup wizard to gather the information it needs 
to recommend the components required by your wireless network. 

To design a new network 
1 Start ProSoft Wireless Designer. 
2 On the splash screen, choose Design a New Network. 

 

Tip: If ProSoft Wireless Designer is already running, open the File menu, and then choose New.  

3 Enter the network name (page 37). Choose an informative name to identify 
the location and purpose for the network, and then click OK to continue. 

4 On the first wizard page, choose the environment: indoor or outdoor. This 
choice determines the type of antennas and other components to use.  

5 Choose the radio type from the dropdown list.  
o Chose "I don't know" if you would like ProSoft Wireless Designer to 

recommend the radio based on your answers on the next wizard pages, 
for example Ethernet or Serial, and with or without 802.11x connectivity. 

o If you already know the type of radio to use, select the radio part number 
from the dropdown list. 

6 Choose the country or region where the radio will be installed. Each country 
or region where these radios are sold has its own regulations for frequency 
range, channels, and output power for wireless networks.  

7 Chose whether to draw the network to scale, or to let you arrange the 
network yourself.  

8 Review the wizard summary for correctness, and then click Finish to add the 
first site (radio) to your network.  
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2.5 Adding a Site 

When you have finished creating the network, you will be prompted to add a site.  

To add a site: 
1 In the Enter New Site Data (page 35) dialog box, enter the site name and the 

distance between the radio and the antenna.  

Note: ProSoft Wireless Designer allows you to choose the measurement units to use (English or 
Metric). If you prefer to enter these values in Metric units (meters, kilometers) instead of English 
units (feet, miles), open the Edit menu, choose Settings, and then on the Settings (page 36) dialog 
box, choose Metric. 

2 If you know the latitude and longitude coordinates, click the Lat/Long 
Coordinates button to enter them in the Site Coordinates (page 32) dialog 
box now. 

3 Open the File menu, and then choose Save. ProSoft Wireless Designer will 
save your network using a file name based on the network name you 
entered. 

Tip: Use the Copy and Paste commands on the Edit menu to quickly create duplicates of parts of 
your network, for example if your network design includes a number of similarly configured sites 
and links.  

2.5.1 Adding another Site 

A radio network consists of two or more sites (radios) connected by links. In 
order for your network to communicate, you must add at least one more site. 

To add another site 
1 Click the right mouse button in the Network Diagram view, and then choose 

Add Site. 
2 On the Enter New Site Data (page 35) dialog box, enter the site name, 

distance between radio and antenna and, if you know the latitude and 
longitude for the site, click the Lat/Long Coordinates button to add the site 
coordinates. 

3 Click OK. 
4 Open the File menu, and then choose Save.  
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2.5.2 Entering Site Coordinates 

ProSoft Wireless Designer uses the site coordinates to calculate the precise 
distance between sites. Use the tabs to choose the data entry format compatible 
with your GPS (Global Positioning System) device, or enter the known 
geographical coordinates for the site.  

To enter Site Coordinates 
1 Determine the latitude and longitude coordinates for the site, using a GPS 

device, or from known coordinates.  
2 Right click on a site, and then choose Properties. 
3 On the Site Properties (page 30) dialog box, click the Location button to open 

the Site Coordinates (page 32) dialog box. 
4 Select the tab that best matches the coordinates (Decimal, Degree:Minute, or 

Degree:Minute:Second) 
5 Enter the site coordinates. Be sure to select the correct North/South and 

East/West orientation. 

2.6 Viewing Site Properties 

The Site Properties (page 30) dialog box shows you all the components and 
computed values associated with the current site. Use this dialog box to view or 
modify the settings for Antennas, (page 31) Cables, (page 31) Radio (page 33) 
and Accessories. (page 32)  

To view Site Properties 
1 In the Network Diagram view, select the Site to view, and then right-click to 

select Properties. 
2 In the Site Properties dialog box, click the icons or buttons for each 

component to view or modify the selections.  

Important: The Antenna, Cables and Accessories in the Site Properties are chosen by ProSoft 
Wireless Designer based on the default items selected in the Settings dialog box. You may need to 
modify those choices for each site to accommodate the specific requirements for each location.  
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2.7 Adding a Link 

In order for each site to communicate with its neighbor, you must create a link. 
The link contains information on the distance between sites, which ProSoft 
Wireless Designer uses to estimate the signal strength and link quality.  

To add a link: 
1 Click the right mouse button in the Network Diagram view, and then choose 

Link Tool.  
2 Move the mouse pointer to the first site, then drag the mouse pointer to the 

second site.  

Tip: "Drag" means click and hold the left mouse button at the starting point, and continue holding 
the left mouse button as you move the mouse pointer to the ending point. Release the left mouse 
button to finish. 

3 In the Enter New Link Data (page 35) dialog box, enter the distance between 
the sites.  

4 Open the File menu, and then choose Save.  

Tip: If you have already entered Latitude and Longitude coordinates for the two sites, ProSoft 
Wireless Designer will calculate the link distance automatically.  

2.8 Viewing Link Properties 

The Link Properties (page 34) dialog box shows you information about the link 
between two sites (radios), including distance, signal strength and link status. 
Signal levels and link status are computed from the link distance and the 
combination of components for the two sites. 

To view Link Properties 
1 In the Network Diagram view, double-click the Link to view 
2 In the Link Properties dialog box, review the distance and link qualities, and 

make a note of any changes that may be required to improve link 
performance. 

2.9 Adding Antennas 

Antennas are selected for you automatically, based on information you provided 
in the setup wizard.  

To view or change the antenna for a site 
1 Right click on a site, and then choose Properties. 
2 On the Site Properties (page 30) dialog box, click the Antenna icon to open 

the Antenna Selection (page 31) dialog box. 
3 Use the dropdown lists to choose the antenna type and antenna part number. 
4 Click OK to save your changes, or click Cancel to discard without saving. 
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2.10 Adding Cables 

Cables are selected for you automatically, based on information you provided in 
the setup wizard.  

To view or change the cables for a site 
1 Right click on a site, and then choose Properties. 
2 On the Site Properties (page 30) dialog box, click the Extension Cable or 

Conversion Cable buttons to open the Cable Selection (page 31) dialog box. 
3 Use the dropdown lists to choose the connector types, length and cable type. 
4 Click OK to save your changes, or click Cancel to discard without saving. 

2.11 Adding Lightning Protection 

If you choose "outdoor", lightning protection (page 75) is selected automatically.  

To view or change the lightning protector for a site 
1 Right click on a site, and then choose Properties. 
2 On the Site Properties (page 30) dialog box, click the Lightning Protector 

button to open the Lightning Protector (page 32) dialog box. 
3 Select (check) or clear (uncheck) the Enable Lightning Protector check box.  
4 Use the dropdown lists to choose the antenna type and antenna part number. 
5 Click OK to save your changes, or click Cancel to discard without saving. 

Important: Outdoor antennas and radios ordinarily require lightning protection, to reduce the 
likelihood damage to equipment or injury to personnel in case of lightning strike.  
Lightning protection should be installed as close to the antenna as possible, and requires a 
minimum 6 gauge wire (not supplied) connecting the lightning protector to ground. When properly 
installed with a heavy gauge ground wire, the lightning protector is capable of protecting against 
multiple lightning strikes.  



Using ProSoft Wireless Designer PSW-PWD ♦ ProSoft Software 
User Manual ProSoft Wireless Designer 

 

 
ProSoft Technology, Inc. Page 25 of 91 
July 8, 2009 
 

 

2.12 Modifying an Existing Network 

When you save your network, ProSoft Wireless Designer creates a file containing 
information about your sites, links and accessories, so that you can view or 
modify your network design later. 

Tip: ProSoft has provided a sample application consisting of a variety of sites, relays and devices, 
to show how a wireless network might be designed. The file name is Wireless Oil Network.wdd, 
Refer to About the Sample Application (page 13) to see how to use this file.  

To open an existing network: 
1 Open the File menu, and then choose Open. 

 

2 Select the file, and then click Open. 

Tip: ProSoft Wireless Designer remembers the last location where you opened or saved files. 
When you use ProSoft Wireless Designer for the first time, it uses its installation folder (normally 
C:\Program Files\ProSoft\ProSoft Wireless Designer).  

2.13 Saving a Network 

You should save your work frequently when you are designing a network. You 
can open the saved file later to view or modify your network design. 

To save a network design 
1 Open the File menu, and then choose Save.  
2 ProSoft Wireless Designer will save your network using a file name based on 

the network name you entered. 
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2.14 Exporting Wizard Choices 

You can export the setup wizard choices for your network design into a variety of 
file formats, for use in other applications. The information in the exported file may 
be useful for technical support and diagnostics.  

The available formats are  
 .csv (comma separated values) for spreadsheets / databases 
 .txt (plain text) for word processor / email 
 .xml for whatever supports xml 

To export wizard choices: 
1 Open the File menu, and then choose Export Wizard Choices. 
2 Choose the location for the export files 
3 Select the file format in the Save as type dropdown list.  
4 Click Save. 

Tip: ProSoft Wireless Designer remembers the last location where you opened or saved files. 
When you use ProSoft Wireless Designer for the first time, it uses its installation folder (normally 
C:\Program Files\ProSoft\ProSoft Wireless Designer).  

2.15 Exporting Site Details 

You can export the site details for your network design into a variety of file 
formats, for use in other applications.  

The available formats are  
 .csv (comma separated values) for spreadsheets / databases 
 .txt (plain text) for word processor / email 
 .xml for whatever supports xml 

To export wizard choices: 
1 Open the File menu, and then choose Export Network Details / Site 

Details. 
2 Choose the location for the export files 
3 Select the file format in the Save as type dropdown list.  
4 Click Save. 

Tip: ProSoft Wireless Designer remembers the last location where you opened or saved files. 
When you use ProSoft Wireless Designer for the first time, it uses its installation folder (normally 
C:\Program Files\ProSoft\ProSoft Wireless Designer).  
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2.16 Exporting Link Details 

You can export the link details for your network design into a variety of file 
formats, for use in other applications.  

The available formats are  
 .csv (comma separated values) for spreadsheets / databases 
 .txt (plain text) for word processor / email 
 .xml for whatever supports xml 

To export wizard choices: 
1 Open the File menu, and then choose Export Network Details / Link 

Details. 
2 Choose the location for the export files 
3 Select the file format in the Save as type dropdown list.  
4 Click Save. 

Tip: ProSoft Wireless Designer remembers the last location where you opened or saved files. 
When you use ProSoft Wireless Designer for the first time, it uses its installation folder (normally 
C:\Program Files\ProSoft\ProSoft Wireless Designer).  

2.17 Exporting a Parts List 

You can export a parts list for your network design into a variety of file formats, 
for use in other applications.  

The available formats are  
 .csv (comma separated values) for spreadsheets / databases 
 .txt (plain text) for word processor / email 
 .xml for whatever supports xml 

To export wizard choices: 
1 Open the File menu, and then choose Export Parts List 
2 Choose the location for the export files 
3 Select the file format in the Save as type dropdown list.  
4 Click Save. 

Tip: ProSoft Wireless Designer remembers the last location where you opened or saved files. 
When you use ProSoft Wireless Designer for the first time, it uses its installation folder (normally 
C:\Program Files\ProSoft\ProSoft Wireless Designer).  
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2.18 Printing 

You can print the current view (Network Diagram, Parts List, Site Details or Link 
Details. ProSoft Wireless Designer offers the following options to customize the 
appearance of printed pages: 

To view or modify Print Settings 
1 Open the File menu, and then choose Application Print Settings. 
2 On the Print Settings (page 35) dialog box, select print scale, background 

color and header font preferences. 

To view or modify Page Layout 
1 Open the File menu, and then choose Page Layout  
2 On the Page Setup dialog box, select paper size, source, orientation and 

margins.  

To view a Print Preview 
1 Open the File menu, and then choose Print Preview. 
2 Review the preview, and modify the print settings or page layout as needed. 

To Print the current view 
1 Open the File menu, and then choose Print. 
2 Select the printer, page range and number of copies to print 
3 Click the Print to use the selected printer to print your pages. 
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3 ProSoft Wireless Designer User Interface 

In This Chapter 

 Site Properties dialog box......................................................................30 
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 Radio Selection dialog box ....................................................................33 

 Link Properties dialog box .....................................................................34 

 Enter New Link Data dialog box ............................................................35 

 Enter New Site Data dialog box.............................................................35 

 Print Settings dialog box........................................................................35 
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 Network Link Details..............................................................................39 
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 View Menu.............................................................................................41 

 Help Menu .............................................................................................41 

 Toolbars ................................................................................................41 

ProSoft Wireless Designer uses standard Windows (page 79) menus, keyboard 
and mouse controls. The following topics describe the ProSoft Wireless Designer 
user interface, and provide tips on how to design your network and create a Bill 
of Materials or parts list to place your order, or to document your installation. 
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3.1 Site Properties dialog box 
This dialog box opens when you right-click the Site (radio) icon and choose 
Properties in the Network Diagram  (page 38)view. Use this dialog box to view or 
change the hardware selection information for this site.  
 Antenna Icon: Shows a drawing of the selected antenna. Click this icon to 

open the Antenna Selection (page 31) dialog box.  
 Site Details: Type the name of the site in this field. The site name is 

displayed in the Network Diagram view. Choose an informative name for your 
site, for example "Headquarters," or "Relay", or "Remote site", to identify the 
location and purpose for the site. 

 Set/View Location: Click this button to open the Site Coordinates (page 32) 
dialog box, to view or enter latitude and longitude coordinates for the site. 
ProSoft Wireless Designer uses the site coordinates to calculate the precise 
distance between sites.  

 Location: Select (check) this check box to use the site lat/long coordinates to 
determine site location and link distance(s).  

 EIRP: Equivalent isotropically radiated power (EIRP) is effective power that is 
radiated from the antenna. It is the net result of the radio transmit power plus 
antenna gain minus all losses from cables and lightning protection. This value 
is calculated based on the hardware specified for this site.  

 Cable/Antenna gain: This is the amount of antenna gain minus all losses 
from cables and lightning protection. This value is calculated based on the 
hardware specified for this site.  

 Max EIRP: This is the maximum EIRP value allowed for the particular region 
and configuration selected. If your configuration exceeds the maximum 
allowable EIRP, a message box will open, and the color of the EIRP text 
changes to red.  

 Antenna: This is the part number for the specified antenna. Click this button 
to open the Antenna Selection dialog box. 

 Extension cable: This is the part number for the specified extension cable. 
Click this button to open the Cable Selection (page 31) dialog box. 

 Lightning protector: This is the part number for the specified lightning 
protector. Click this button to open the Lightning Protector Selector (page 32) 
dialog box. 

 Conversion cable: This is the part number for the specified conversion 
cable. Click this button to open the Cable Selection (page 31) dialog box. 

 Additional Loss [dB]: Enter an amount of miscellaneous loss for any 
components that might not be included. 

 Distance to antenna: Enter the distance in feet or meters between the radio 
and the antenna.  

 Radio: The part number for the specified radio. Click this button open the 
Radio Selection dialog box (page 33). Note that the radio type is selected for 
you automatically, based on your answers to the setup wizard. If you change 
the radio type to a radio that is not compatible with the rest of the site, the 
new radio will not be able to communicate with the network. 

 Power level: Choose the transmit power level for this radio from the 
dropdown list. 

 Frequency range: The frequency range in MHz for the specified radio. 
 Antenna Port Use: This dropdown box is used to switch between the single 

antenna site properties dialog and the two antenna site properties dialog.  
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3.2 Antenna Selection dialog box 

This dialog box opens when you click the Antenna icon on the Site Properties 
(page 30) dialog box. Use this dialog box to view or change (page 23) the 
antenna type specified for the site.  
 Antenna Icon: Shows a drawing of the selected antenna.  
 Connector: Shows the connector type specified for the antenna, for example 

N_F_jack. 
 Antenna Type: Antennas are grouped into categories, for example Omni, 

Parabolic, Patch or Yagi. Open the dropdown list to choose a different 
antenna type. 

 Gain: This is the gain in dBi for the specified antenna. 
 Frequency range: This is the frequency range in MHz for the specified 

antenna. 
 Description: This is a brief description of the specified antenna, for example 

"24 dBi Directional N jack parabolic".  
 Part #: This is a list of part numbers for antennas of this type. Select the 

antenna type from the list box. Notice that the information fields on this dialog 
box change as you select different part numbers.  

3.3 Cable Selection dialog box 

This dialog box opens when you click the Conversion cable or Extension cable 
buttons on the Site Properties (page 30) dialog box. Use this dialog box to view 
or change (page 24) the cable type specified for the site.  
 Cable Icon: Shows a drawing of the selected cable. 
 1st Connector, 2nd Connector: Shows the connector type specified for 

each end of the cable. Use the dropdown list for each connector to choose a 
different connector type.  

 Code: Shows the part numbering code corresponding to that connector 
 Part #: This is the part number for the selected cable.  
 Description: This is a brief description for the selected cable, for example 

"40ft LMR 400 N plug --> N plug cable". 
 Select length: This is the length in feet or meters for the selected cable. Use 

the dropdown list to choose a different cable length. 
 Select type: This is the cable type for the specified cable, for example 

LMR_400. Use the dropdown list to choose a different cable type.  
 Approximate Loss: This is the approximate signal loss for the specified 

cable, for example 2.56 dB. Signal loss is calculated based on the cable type, 
connectors, and cable length.  

 Remove Cable: Click this button to remove the cable from the specification. 
Note that the cables and connectors specified for your site include all the 
necessary adaptors to connect the various components. A message box will 
open if you attempt to delete a cable that provides necessary connections 
between components.  
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3.4 Lighting Protector dialog box 

This dialog box opens when you click the Lightning Protector icon on the Site 
Properties (page 30) dialog box. Use this dialog box to include or exclude 
lightning protection (page 24) hardware for your site.  

Important: Outdoor antennas and radios ordinarily require lightning protection, to reduce the 
likelihood damage to equipment or injury to personnel in case of lightning strike.  
Lightning protection (page 75) should be installed as close to the antenna as possible, and requires 
a minimum 6 gauge wire (not supplied) connecting the lightning protector to ground. When properly 
installed with a heavy gauge ground wire, the lightning protector is capable of protecting against 
multiple lightning strikes.  

 Enable lightning protector: Select (check) this option if this site requires 
lightning protection hardware.  

3.5 Site Coordinates dialog box 

This dialog box opens when you click the Location button on the Site Properties 
(page 30) dialog box. Use this dialog box to view or enter Latitude and Longitude 
(page 22) coordinates for this site. ProSoft Wireless Designer uses the site 
coordinates to calculate the precise distance between sites. Use the tabs to 
choose the data entry format compatible with your GPS (Global Positioning 
System) device, or enter the known geographical coordinates for the site.  
 Decimal Degree: Click this tab to enter coordinates in Decimal Degree 

format, for example "23.932168" 
 Degree: Minute: Click this tab to enter coordinates in Degree:Minute format, 

for example "23:55.93008" 
 Degreee: Minute: Second: Click this tab to enter coordinates in 

Degree:Minute:Second format, for example "23:55:55.804" 
 Latitude: Degrees latitude relative to the Equator (0 degrees) 
 North: Select North for locations north of the equator 
 South: Select South for locations south of the equator 
 Longitude: Degrees longitude relative to the Greenwich Meridian (0 

degrees) 
 East: Select East for locations east of the Greenwich Meridian 
 West: Select West for locations west of the Greenwich Meridian 
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3.6 Radio Selection dialog box 

This dialog box opens when you click the Radio icon in the Site Properties (page 
30) dialog box. Use this dialog box to view or modify the radio settings for the 
site. Note that the radio type is selected for you automatically, based on your 
answers to the setup wizard. If you change the radio type to a radio that is not 
compatible with the rest of the site, the new radio will not be able to communicate 
with the network.  
 Radio type: Choose the radio type from the dropdown list. 
 Region: Each country or region where these radios are sold has its own 

regulations for frequency range, channels, and output power for wireless 
networks. Open the dropdown list to choose the country where this radio will 
be used.  

 Part #: This is the part number for the specified radio, based on the selected 
radio type and country. 

 Band setting: This is the frequency range in MHz supported by the selected 
radio. 

 Device types: This is the protocol type or types supported by the selected 
radio. 

 Power level: Choose the output strength for this radio from the dropdown list.  
 Description: This is a brief description of the selected radio, for example "2.4 

GHz Frequency Hopping Wireless Ethernet Switch". 
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3.7 Link Properties dialog box 

This dialog box opens when you double-click the Link (colored line) connecting 
two sites in the Network Diagram View (page 38).  

 

Use this dialog box to view or change the distance of the link, and to view the 
calculated link strength and status for the link.  
 Distance: Enter the distance in miles between sites for this link. 
 Data Rate: This is the rate that RF packets are being transferred. 
 Free Space Loss: This is the loss of signal strength between two sites.  
 Earth Curvature: The calculated curvature of the earth between Site 1 and 

Site 2.  
 Fresnel Zone: The calculated Fresnel zone between Site 1 and Site 2. The 

Fresnel zone defines the unobstructed area around the direct path of the 
signal.  

 Name: The name of each site associated with this link.  
 Signal level: The signal level for each site associated with this link. 
 Signal levels (Excellent, Good, Poor, or Broken): These are the values in 

dBm that ProSoft Wireless Designer uses to predict the status of the link.  
 Link strength: This is the strength in dBm calculated by ProSoft Wireless 

Designer, based on the hardware selected for each site in the link, and the 
distance between the two sites.  

 Link status: This is the status (excellent, good, poor, or broken) predicted by 
ProSoft Wireless Designer, based on the hardware selected for each site in 
the link, and the distance between the two sites.  

Important: These values are calculated by ProSoft Wireless Designer based on the hardware 
specifications and link distances you provide for the network design. Other factors, including terrain 
and interference from other devices may affect the actual signal properties when the network is 
deployed.  
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3.8 Enter New Link Data dialog box 

This dialog box opens when you select the Link Tool, and then drag a new link 
between two sites in the Network Diagram (page 38) view. Use this dialog box to 
specify the distance between sites. ProSoft Wireless Designer uses this 
information to calculate link strength and status for the link.  
 Distance: Enter the distance between the two sites connected by this link. 

3.9 Enter New Site Data dialog box 

This dialog box opens when you select the Site Tool, and then click in the 
Network Diagram (page 38) view to add a new Site (radio) to your network.  
 Enter a name for this site: Type the name of the site in this field. The site 

name is displayed in the Network Diagram view. Choose an informative name 
for your site, for example "Headquarters," or "Relay", or "Remote site", to 
identify the location and purpose for the site. 

 Distance between radio and antenna: Enter the distance between the radio 
and its antenna. ProSoft Wireless Designer uses this information to specify 
cables, connections and antennas for the site.  

 Change Radio Type: Click this button to open the Radio Type Selector 
dialog box, where you can a new radio type.  

 Lat/Long Coordinates: Click this button to open the Site Coordinates (page 
32) dialog box, where you can enter the latitude and longitude coordinates for 
the site.  

3.10 Print Settings dialog box 

This dialog box opens when you open the File menu (page 40), and then choose 
Application Print Settings. Use this dialog box to customize the way your network 
diagram (page 38), parts list (page 39), site details (page 39) or link details (page 
39) should appear when printed.  
 Print scale: ProSoft Wireless Designer normally fits the text or diagram 

automatically to the page dimensions you select in the Page Setup dialog 
box. If you prefer, uncheck the Fit to page checkbox to choose the scale 
(magnification) yourself.  

 Fit to page: When this box is selected (checked), ProSoft Wireless Designer 
scales the text or diagram automatically to the page dimensions you select in 
the Printer Preferences dialog box for your printer.  

 Draw background color: When this box is selected (checked), ProSoft 
Wireless Designer prints the background color along with the data from the 
view you are printing. Uncheck this box if you prefer to print the data without 
printing the background color.  

 Adjust Header Font: Click this button to choose a different font, style and 
size for the header and footer text that ProSoft Wireless Designer prints on 
each page. The header and footer text include the Network Name, Network 
View and Page Number. Use the Print Preview command to view pages 
before printing.  
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3.11 Settings dialog box 

This dialog box opens when you open the Edit menu (page 40), and then choose 
Settings. Use this dialog box to view or change (page 12) the Application settings 
and Document settings that ProSoft Wireless Designer should use for its user 
interface, and for new networks, sites, and regions. In most cases, you can 
change these default (predefined) settings from the Site Properties dialog box.  
 Measuring Units: Choose English (feet, miles) or Metric (meters, 

kilometers). 
 Disable warnings:  Click this box to remove warnings that a user would 

frequently see. 
 Network name: This field contains the network name for the current network. 

To change the network name, enter the new name in this field.  
 Radio: Click this button to open the Radio Selection dialog box, and then 

choose the default radio to use for new sites.  
 Lightning protector: This field is provided for information only, and lists the 

part number for the specified lightning protector. 
 Cabled antenna: Click this button to open the Antenna Selection dialog box, 

and then choose the default Directional antenna (Parabolic, Patch or Yagi) to 
use for new sites.  

 Direct mount antenna: Click this button to open the Antenna Selection 
dialog box, and then choose the default Omnidirectional antenna to use for 
new sites.  

 Conversion cable length: Enter the default length for the conversion cable 
to use for new sites. 

 Band: This is the default band that a new site would default to when added. 
 Environment: Select Outdoor or Indoor for the environment to use for new 

sites.  
 Site font: Click this button to choose the font, style and size to use in the 

captions for sites and links in the Network Diagram view.  
 Site image size: Click this button to open the Select Site Image dialog box, 

and then choose the image size (small, medium, large) to use for sites in the 
Network Diagram view.  

 Draw to scale: Select (check) this check box to arrange Sites (radios) by 
distance in the Network view.  

 Show link details: This checkbox controls whether the site details box is 
displayed inbetween the links.  
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3.12 Customize Application Colors dialog box 

This dialog box opens when you open the View menu, and then choose 
Customize Colors (page 12). Use this dialog box to choose a predefined color 
scheme (for example, Blue, Orange, Brown, White, and so on), or customize 
your own color scheme.  

3.13 Select Site Image dialog box 

This dialog box opens when you click the Site Image Size button on the Settings 
(page 36) dialog box. Use this dialog box to choose the image size (small, 
medium, large) for sites (radios) in the Network Diagram view. 

3.14 Network Name dialog box 

This dialog box opens when you open the File menu, and then select New. Use 
this dialog box to create and name a new wireless network. 
 Network Name: Enter the name for your network in this field. 
 This Network is: Select whether its an indoor or outdoor network. 
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3.15 Network Diagram View 

The Network Diagram view is a symbolic layout of your wireless network. A 
wireless network consists of sites (radios plus their associated cables, antennas 
and accessories), plus links between sites.  

When you create a wireless network, you first specify a network name, then add 
sites, and then links. While you design your network, ProSoft Wireless Designer 
calculates distances, signal strength and required hardware, and then provides 
that information in a comprehensive parts list that you can use to order the 
necessary components from your ProSoft distributor.  

The following illustration shows the Network Diagram view for the Wireless Oil 
Network sample configuration. 

 

  Use the buttons on the Zoom tool bar to enlarge, reduce, or fit the 
diagram to the size of the window.  

 Use the mouse wheel to scroll up and down within the window.  
 Press and hold the [Ctrl] key and use the mouse wheel to zoom in and out.  
 Press and hold the [Shift] key and use the mouse wheel to scroll left and 

right.  
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3.16 Network Parts List 

Click the Parts List tab to view part numbers, quantities and descriptions for each 
of the components required for your network design.  

Open the File menu and then choose Export Parts List to create a file that you 
can import into a variety of other applications. Choices include Comma 
Separated Values (.csv) for spreadsheets and database applications, Text (.txt) 
for word processors, or XML (.xml) for applications that support eXtensible 
Markup Language.  

Tip: Use the mouse to drag-select all or part of the parts list, and copy it to the clipboard. You can 
paste the clipboard directly into a word processor or spreadsheet.  

3.17 Network Site Details 

Click the Site Details tab to view detailed information about each site.  

Open the File menu and then choose Export Network Details / Site Details to 
create a file that you can import into a variety of other applications. Choices 
include Comma Separated Values (.csv) for spreadsheets and database 
applications, Text (.txt) for word processors, or XML (.xml) for applications that 
support eXtensible Markup Language.  

Tip: Use the mouse to drag-select all or part of the site details and copy it to the clipboard. You can 
paste the clipboard directly into a word processor or spreadsheet.  

Notice that the Site Details tab shows details for only one site at a time. Use the 
Next and Previous buttons to view the rest of the sites in your network.  

3.18 Network Link Details 

Click the Link Details tab to view detailed information about each link.  

Open the File menu and then choose Export Network Details / Link Details to 
create a file that you can import into a variety of other applications. Choices 
include Comma Separated Values (.csv) for spreadsheets and database 
applications, Text (.txt) for word processors, or XML (.xml) for applications that 
support eXtensible Markup Language.  

Tip: Use the mouse to drag-select all or part of the link details and copy it to the clipboard. You can 
paste the clipboard directly into a word processor or spreadsheet.  

Notice that the Link Details tab shows details for only one link at a time. Use the 
Next and Previous buttons to view the rest of the links in your network.  
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3.19 File Menu 

Use the commands on the File Menu to create, open, save or rename project 
files, or to exit (close) the ProSoft Wireless Designer.  
 New: Starts the Network Design Wizard, which gathers information to create 

a new ProSoft Wireless Designer network design document.  
 Open: Opens an existing network design document.  
 Close: Closes the current network design document.  
 Save: Saves the current network design document without closing, so you 

can continue editing. 
 Save as: Saves the current network design document, allowing you to 

change the file name. 
 Export Wizard Choices: Saves a copy of the selections you made in the 

Network Design Wizard, in CSV (spreadsheet), TXT (text) or XML format, for 
use in other applications.  

 Export Network Details: Saves a copy of the Site details or Link details, in 
CSV (spreadsheet), TXT (text) or XML format, for use in other applications.  

 Export Parts List: Saves a copy of the Parts List, in CSV (spreadsheet), 
TXT (text) or XML format, for use in other applications.  

 Application Print Settings: Opens the Print Settings (page 35) dialog box, 
to customize the appearance of pages you print from ProSoft Wireless 
Designer. 

 Page Layout: Opens the Page Layout dialog box, to customize the paper 
size orientation and margins of pages you print from ProSoft Wireless 
Designer. 

 Print: Opens the Print dialog box, to select and print pages from ProSoft 
Wireless Designer.  

 Print Preview: Opens the Print Preview dialog box, to show you how the 
pages will look when you print them.  

 Exit: Closes ProSoft Wireless Designer.  

3.20 Edit Menu 

Use the Edit menu to view or change system settings, and to copy, paste or 
delete an item in the Network Diagram view, or to copy all or part of the Parts 
List, Site Details or Link Details to the Windows clipboard.  
 Undo: Undoes (reverts) the last editor action.  
 Redo: Redoes an editor action after an Undo.  
 Settings: Opens the Settings (page 36) dialog box, to view and change the 

default values for ProSoft Wireless Designer 
 Cut: Copies and deletes the selected site or link in order to paste it in another 

location.  
 Copy: Copies the selected site or link in order to paste it in another location. 
 Paste: Pastes the selected site or link that was copied or cut.  
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3.21 View Menu 

Use the View Menu to customize application colors, show or hide the Tool Bars, 
or expand or condense the Network View to fit the current window size.  
 Customize Colors: Opens the Customize Application Colors (page 37) 

dialog box, to choose a predefined color scheme (for example, Blue, Orange, 
Brown, White, and so on), or customize your own color scheme. 

 Update View Size: Centers the Sites (radios) and Links in the Network 
Diagram (page 38) view in the current window. 

 Toolbars: Hides or un-hides the selected toolbar. (page 41)  

3.22 Help Menu 

Use the Help Menu to view the help pages for ProSoft Wireless Designer, or to 
view version information for the program.  

3.23 Toolbars 

Toolbars display frequently-used commands in graphic form, and provide an 
alternative method of choosing commands.  

To turn toolbars on or off, open the View menu, select Toolbars, and then choose 
the toolbar to view or hide.  
 Standard 

 
 Toolbox 

 
 Zoom 

 
Drag a toolbar by its "handle" to reposition it in the ProSoft Wireless Designer.  
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4 Glossary of Terms 

8 

802.11 
A group of wireless specifications developed by the IEEE. It details a wireless 
interface between devices to manage packet traffic. 

802.11a 
Operates in the 5 GHz frequency range with a maximum 54 Mbit/sec signaling 
rate. 

802.11b 
Operates in the 2.4 GHz Industrial, Scientific, and Measurement (ISM) band. 
Provides signaling rates of up to 11 Mbit/sec and is the most commonly used 
frequency. 

802.11g 
Similar to 802.11b but supports signaling rates of up to 54 Mbit/sec. Operates in 
the heavily used 2.4 GHz ISM band but uses a different radio technology to boost 
throughput. 

802.11i 
Sometimes Wi-Fi Protected Access 2 (WPA 2). WPA 2 supports the 128-bit and 
above advanced encryption Standard, along with 802.1x authentication and key 
management features. 

802.11n 
Designed to raise effective WLAN throughput to more than 100 Mbit/sec. 

802.11s 
Deals with mesh networking. 

A 

Access Point 
A generic term for an 802.11 radio that "attaches" other 802.11 radios (clients) to 
a wired network. APs can also bridge to one another. 

Ad hoc Mode 
Wireless network framework in which devices can communicate directly with one 
another without using an AP or a connection to a regular network. 
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AES 
Advanced Encryption Standard. New standard for encryption adopted by the U.S. 
government for secure communications. 

Amplifier 
A device connected to an antenna used to increase the signal strength and 
amplify weak incoming signals. 

Antenna 
A device connected to a wireless transceiver that concentrates transmitted and 
received radio waves to increase signal strength and thus the effective range of a 
wireless network. 

ASCII 
American Standard Code for Information Interchange. A communication mode in 
which each eight-bit byte in a message contains one ASCII character code. 
ASCII characters (or hexadecimal characters) are sometimes used as a key to 
encrypt data and ensure its secure transmission. 

Association 
Process whereby two 802.11 radios establish communications with each other. 
Requirements for communication include common SSID (network names) and 
encryption settings. 

Authenticate 
The process of confirming the identity of someone connecting to a network. 

Authentication Server 
A back-end database server that confirms the identity of a supplicant to an 
authenticator in an 802.1x-authenticated network. 

B 

Band 
Another term for spectrum used to indicate a particular set of frequencies. 
Wireless networking protocols work in either the 2.4 GHz or the 5 GHz bands. 

Bandwidth 
(See Throughput) 

Base Station 
See Wireless Gateway 

Baud Rate 
The speed of communication between devices on the network. All devices must 
communicate at the same rate. 
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bps 
Bits per Second. A measure of data transmission speed across a network or 
communications channel;bps is the number of bits that can be sent or received 
per second. 

C 

Channel 
One portion of the available radio spectrum that all devices on a wireless network 
use to communicate. Changing the channel on the access point/router can help 
reduce interference. 

Client 
A client is software program, or the device on which that program runs, that 
makes requests for information from a software program, or the device on which 
that program runs, in a client-server relationship.  

A Client on an Ethernet network is equivalent to a Master on a serial network.  

Configuration PC 
A Computer that contains the  Setup/Diagnostic software (for Frequency Hopping 
radios), or RadioLinx IH Browser Setup/Diagnostic software (for Industrial 
Hotspot and Industrial Broadband radios). 

D 

dBi 
Decibels referenced to an "ideal" isotropic radiator in free space; frequently used 
to express antenna gain 

dBm 
Decibels referenced to one milliwatt (mW); an "absolute" unit used to measure 
signal power (transmit power output or received signal strength) 

DCE 
Data communications equipment. A modem, for example.  

Decibel (dB) 
A measure of the ratio between two signal levels; used to express gain (or loss) 
in a system. 

Default Gateway 
The IP address of a network router where data is sent if the destination IP 
address is outside the local subnet. The gateway is the device that routes the 
traffic from the local area network to other networks such as the Internet. 
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Device-to-Device Network (Peer-to-Peer Network) 
Two or more devices that connect using wireless network devices without the 
use of a centralized wireless access point. Also known as a peer-to-peer 
network. 

DHCP 
The dynamic host configuration protocol is an Internet protocol, similar to BootP, 
for automating the configuration of computers that use TCP/IP. DHCP can be 
used to automatically assign IP addresses, to deliver IP stack configuration 
parameters, such as the subnet mask and default router, and to provide other 
configuration information, such as the addresses for printer, time, and news 
servers. 

Direct Sequence Spread Spectrum 
One of two approaches (with frequency hopping spread spectrum) for sorting out 
overlapping data signals transmitted via radio waves. 802.11b uses DSSS 

Directional Antenna 
Transmits and receives radio waves off the front of the antenna. 

Diversity Antenna 
An antenna system that uses multiple antennas to reduce interference and 
maximize reception and transmission quality. 

DTE 
Data Terminal Equipment, for example, a computer or terminal. 

Dual Band 
A device that is capable of operating in two frequencies. On a wireless network, 
dual-band devices are capable of operating in both the 2.4 GHz (802.11b/g) and 
5 Hz (802.11a) bands. 

E 

EAP 
Extensible Authentication Protocol. A protocol that provides an authentication 
framework for both wireless and wired Ethernet enterprise networks. 

EIRP 
Equivalent isotropically radiated power (EIRP) is the amount of power that would 
have to be emitted by an isotropic antenna (that evenly distributes power in all 
directions and is a theoretical construct) to produce the peak power density 
observed in the direction of maximum antenna gain. 

Encryption 
Method of scrambling data so that only the intended viewers can decipher and 
understand it. 
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ESD 
Electrostatic Discharge. Can cause internal circuit damage to the coprocessor. 

ESSID 
Extended Service Set Identifier. A name used to identify a wireless network. 

F 

Firmware 
Firmware is the embedded software code that that runs in the module to direct 
module function (similar to the BIOS in a personal computer). This is 
distinguished from the Setup/Diagnostic Application software that is installed on 
the Configuration PC. 

Frequency Hopping 
A radio that rapidly changes its operating frequency several times per second 
following a pre-determined sequence of frequencies. The transmitting and 
receiving radios are programmed to follow the same frequency hopping 
sequence. 

Frequency Hopping Spread Spectrum 
Changes or hops frequencies in pattern known to both sender and receiver. 
FHSS is little influenced by radio stations, reflections, or other environmental 
factors. However, it is much slower than DSSS. 

Fresnel Zone 
An elliptical area on either side of the straight line of sight that must also be clear 
for a long-range wireless network to work. 

Full-Duplex 
A communications circuit or system designed to simultaneously transmit and 
receive two different streams of data. Telephones are an example of a full-duplex 
communication system. Both parties on a telephone conversation can talk and 
listen at the same time. If both talk at the same time, their two signals are not 
corrupted. 

G 

Gain 
The amount by which an antenna concentrates signal strength in a wireless 
network. 

Gateway 
In wireless terms, a gateway is an access point with additional software 
capabilities such as providing NAT and DHCP. 



PSW-PWD ♦ ProSoft Software Glossary of Terms 
ProSoft Wireless Designer  User Manual 

 

 
Page 48 of 91  ProSoft Technology, Inc. 

July 8, 2009 
 

H 

Half-Duplex 
A communications circuit or system designed to transmit and receive data, but 
not both simultaneously. CB or walkie-talkie radios are an example of a half-
duplex communication system. Either parties on a radio conversation may talk or 
listen; but both cannot talk at the same time without corrupting each other's 
signal. If one operator is "talking", the other must be "listening" to have 
successful communication. 

Hz 
Hertz. The international unit for measuring frequency equivalent to the older unit 
of cycles per second. One megahertz (MHz) is one million hertz. One gigabit 
(GHz) is one billion hertz. The standard US electrical power frequency is 60 Hz. 
802.11a devices operate in the GHz band; 802.11b and g devices operate in the 
2.4 GHz band. 

I 

IEEE 
Institute of Electrical and Electronics Engineers, Inc. IEEE is a professional 
organization with members in over 175 countries and is an authority in technical 
areas such as computer engineering and telecommunications. IEEE developed 
the 802.11 specifications. 

IP Address 
A 32-bit identification number for each node on an Internet Protocol network. 
These addresses are represented as four sets of 8-bit numbers (numbers from 0 
to 255), with decimals between them. Networks using the TCP/IP Protocol route 
messages based on the IP address of the destination. Each number can be 0 to 
255. For example, 192.168.0.100 could be an IP address. Each node on the 
network must have a unique IP address.   

K 

Key 
A set of information (often 40 to as much as 256 bits) that is used as a seed to an 
encryption algorithm to encrypt (scramble) data. Ideally, the key must also be 
known by the receiver to decrypt the data. 

L 

LAN 
A system of connecting PCs and other devices within the same physical 
proximity for sharing resources such as internet connections, printers, files, and 
drives. When Wi-Fi is used to connect the devices, the system is known as a 
wireless LAN or WLAN. 
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LED 
Light-emitting diode. 

Line of Sight (LoS) 
A clear line from one antenna to another in a long-range wireless network. 

Link point 
The graphical point next to a radio icon that represents the connection point for 
RF communications between radios. An RF connection between two radios is 
called an RF Link and is represented as a graphical black line between the 
radio’s link points. 

M 

MAC ID 
Media Access Control address. Every 802.11 device has its own MAC address. 
This is a unique identifier used to provide security for wireless networks. When a 
network uses a MAC table, only the 802.11 radios that have had their MAC 
addresses added to the network’s MAC table are able to get on the network. 

Master device 
Device that is connected to the Master radio. 

Mbps 
Megabits per second, or millions of bits per second. A measure of bandwidth. 

Megahertz 
A measure of electromagnetic wave frequency equal to one million hertz. Often 
abbreviated as MHz and used to specify the radio frequency used by wireless 
devices. 

Mesh Networking 
Features free standing, non wired network nodes that communicate among one 
another and form self-configuring networks, with only one node required to hook 
into a wired LAN. The other nodes are simply plugged into an electrical outlet, so 
cabling is much less of an issue. 

MIC 
Message Integrity Check. One of the elements added to the TKIP standard. A 
"signature" is added by each radio on each packet it transmits. The signature is 
based on the data in the packet, a 64-bit value (key) and the MAC address of the 
sender. The MIC allows the receiving radio to verify (check) that the data is not 
forged. 



PSW-PWD ♦ ProSoft Software Glossary of Terms 
ProSoft Wireless Designer  User Manual 

 

 
Page 50 of 91  ProSoft Technology, Inc. 

July 8, 2009 
 

MIMO 
Multiple Input Multiple Output refers to using multiple antennas in a WiFi device 
to improve performance and throughput. MIMO technology takes advantage of a 
characteristic called multipath, which occurs when a radio transmission starts out 
at Point A and the reflects off or passes through surfaces or objects before 
arriving, via multiple paths, at Point B. MIMO technology uses multiple antennas 
to collect and organize signals arriving via these paths. 

Modbus 
The Modbus protocol provides the internal standard that the MODICON® 
controllers use for parsing messages. During communications on a ModBus 
network, the protocol determines how each controller will know its device 
address, recognize a message addressed to it, determine the kind of action to be 
taken, and extract any data or other information contained in the message. If a 
reply is required, the controller will construct the reply message and send it using 
ModBus protocol. 

Modem 
Stands for MODulator-DEModulator, a device that converts digital signals to 
analog signals and vice-versa. Analog signals can be transmitted over 
communications links such as telephone lines. 

N 

Network 
A series of stations or nodes connected by some type of communication medium. 
A network may consist of a single link or multiple links. 

Node 
An address or software location on the network.  

Null Modem Cable 
A specialty cross-communication cable with female connectors on each end used 
for direct connection between devices when no modems are present. Commonly 
used as a quick and inexpensive way to transfer files between two PCs without 
installing a dedicated network card in each PC. 

P 

Panel Antenna 
An antenna type that radiates in only a specific direction. Panel antennas are 
commonly used for point-to-point situations. Sometimes called Patch antennas. 

Parabolic Antenna 
An antenna type that radiates a very narrow beam in a specific direction. 
Parabolic antennas offer the highest gain for long-range point-to-point situations. 
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Peer-to-Peer Network 
Each radio in a Peer-to-Peer network has the ability to receive data from - and 
transmit data to - any other radio in the network. 

Point-Multipoint (Broadcast) Network 
A network type where a single master radio sends data to every remote radio in 
the network. This is done repeatedly until every remote radio individually receives 
and acknowledges the data. Each remote radio sends pending data to the 
master radio that receives and acknowledges data sent from each remote. In this 
configuration, there are multiple remote radios referenced to a single master 
radio. 

Point-Multipoint (Modbus) Network 
A network with a single Master radio and multiple Remote radios. The devices 
cabled to the radios communicate through the Modbus standard protocol. The 
Master radio sends data to a Remote radio based on the Modbus address of the 
Modbus device. The data is only sent to the single Remote device based on its 
address. Each Remote radio sends its data only to the Master radio. The Master 
and Remote radios acknowledge that data was received correctly. 

Point-to-Multipoint 
A wireless network in which one point (the access point) serves multiple other 
points around it. Indoor wireless networks are all point-to-multipoint, and long-
range wireless networks that serve multiple clients usually employ either a single 
omnidirectional antenna or multiple sector antennas. 

Point-to-Point Network 
A network consisting of a single Master radio and a single Remote radio. All data 
from the Master is received and acknowledged by one Remote. All data from the 
single Remote is received and acknowledged by the Master radio. 

Poll 
A method of electronic communication. 

Power Supply 
Device that supplies electrical power to the I/O chassis containing the processor, 
coprocessor, or other modules.  

Protocol 
The language or packaging of information that is transmitted between nodes on a 
network. 



PSW-PWD ♦ ProSoft Software Glossary of Terms 
ProSoft Wireless Designer  User Manual 

 

 
Page 52 of 91  ProSoft Technology, Inc. 

July 8, 2009 
 

Q 

QoS 
Quality of Service. Required to support wireless multimedia applications and 
advanced traffic management. QoS enables Wi-Fi access points to prioritize 
traffic and optimize the way shared network resources are allocated among 
different applications. 

R 

RADIUS 
Remote Access Dial-In Service. This describes a general method for allowing 
remote users access to a network. It authenticates the user, specifies passwords 
and access rights to network resources. It also keeps track of accounting for 
when and how long the user is logged onto the network. It was originally used for 
dial-in users, accessing corporate networks via modems. It is now being 
specified as part of the 802.11i standard to control access of users to wireless 
networks. Any of several protocols can be used by the wireless client to 
communicate with the RADIUS server to gain access to the network resources. 
These protocols include EAP-TLS (Windows), LEAP (Cisco) and EAP-TTLS. 

Range 
The distance covered by a wireless network radio device. Depending on the 
environment and the type of antenna used, Wi-Fi signals can have a range of up 
to a mile. 

Remote Access Point 
One of a number of secondary access points in a wireless network that uses 
WDS to extend its range. Remote access points (sometimes called relay access 
points) connect to a master access point. 

Remote device 
Devices connected remote radios 

Repeater 
A Repeater is a device used to extend the range of a Wi-Fi signal. Placed at the 
edge of signal reception, a repeater simply receives and re-transmits the signal. 

RS-232 
Recommended Standard 232; the standard for serial binary signals between 
DTE and DCE devices. 
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RTU (Remote Terminal Unit) 
Modbus transmission mode where each eight-bit byte in a message contains two 
four-bit hexadecimal characters. There are two transmission modes (ASCII or 
RTU). The main advantage of the RTU mode is that its greater character density 
allows better data throughput than ASCII mode for the same baud rate; each 
message is transmitted in a continuous stream (See also ASCII, above). 

S 

Sector Antenna 
An antenna type that radiates in only a specific direction. Multiple sector 
antennas are commonly used in point-to-multipoint situations. 

Signal Diversity 
A process by which two small dipole antennas are used to send and receive, 
combining their results for better effect. 

Signal Loss 
The amount of signal strength that’s lost in antenna cable, connectors, and free 
space. Signal loss is measured in decibels. Also referred to as gain loss. 

Signal Strength 
The strength of the radio waves in a wireless network. 

Simplex 
A communications circuit or system designed to either transmit data or receive 
data, but not both. Broadcast television is an example of simplex communication 
system. A television station sends a TV signal but cannot receive responses 
back from the television sets to which it is transmitting. The TV sets can receive 
the signal from the TV station but cannot transmit back to the station. 

Site Survey 
A comprehensive facility study performed by network managers to ensure that 
planned service levels will be met when a new wireless LAN, or additional WLAN 
segments to an existing network are deployed. Site survey’s are usually 
performed by a radio frequency engineer and used by systems integrators to 
identify the optimum placement of access points to ensure that planned levels of 
service are met. Site surveys are sometimes conducted following the deployment 
to ensure that the WLAN is achieving the necessary level of coverage. Site 
surveys can also be used to detect rogue access points. 

Spectrum 
A range of electromagnetic frequencies. 
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Spread Spectrum 
A form of wireless communication in which a signal’s frequency is deliberately 
varied. This increases bandwidth and lessens the chances of interruption or 
interception of the transmitted signal. 

SSI 
Service Set Identifier is a sequence of characters unique to a specific network or 
network segment that’s used by the network and all attached devices to identify 
themselves and allow devices to connect to the correct network when one or 
more than one independent network is operating in nearby areas. 

Subnet Mask 
A mask used to determine what subnet an IP address belongs to. An IP address 
has two components: the network address, and the host (node or device) 
address. For example, consider the IP address 150.215.017.009. Assuming this 
is part of a Class B network (with a subnet mask of 255.255.0.0), the first two 
numbers (150.215) represent the Class B network address, and the second two 
numbers (017.009) identify a particular host on this network. 

T 

TKIP 
Temporal Key Integrity Protocol. The wireless security encryption mechanism in 
Wi-Fi Protected Access. TKIP uses a key hierarchy and key management 
methodology that removes the predictability that intruders relied upon to exploit 
the WEP key. In increases the size of the key from 40 to 128 bits and replaces 
WEP’s single static key with keys that are dynamically generated and distributed 
by an authentication server, providing some 500 trillion possible keys tht can be 
used on a given data packet. If also includes a Message Integrity Check (MIC), 
designed to prevent the attacker from capturing data packets, altering them, and 
resending them. By greatly expanding the size of keys, the number of keys in 
use, and by creating an integrity checking mechanism, TKIP magnifies the 
complexity and difficulty involved in decoding data on a Wi-Fi network. TKIP 
greatly increases the strength and complexity of wireless encryption, making it far 
more difficult (if not impossible) for a would-be intruder to break into a Wi-Fi 
network. 

U 

UART 
Universal Asynchronous Receiver/Transmitter 

W 

WAP 
Wireless Application Protocol. A set of standards to enable wireless devices to 
access internet services, such as the World Wide Web and email. 
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WDS 
Wireless Distribution System. Enables access points to communicate with one 
another in order to extend the range of a wireless networks. Used in 802.11g 
based access points. 

WEP 
Wired-Equivalent Privacy protocol was specified in the IEEE 802.11 standard to 
provide a WLAN with a minimal level of security and privacy comparable to a 
typical wired LAN, using data encryption. 

Wi-Fi 
A certification mark managed by a trade group called the Wi-Fi Alliance. Wi-Fi 
certification encompasses numerous standards including 802.11a, 802.11b, 
802.11g, WPA, and more. Equipment must pass compatibility testing to receive 
the Wi-Fi mark. 

Wi-Fi CERTIFIED™ 
The certification standard designating IEEE 802.11-based wireless local area 
network (WLAN) products that have passed interoperability testing requirements 
developed and governed by the Wi-Fi alliance. 

Wi-Fi Interoperability Certificate 
A statement that a product has passed interoperability testing and will work with 
other Wi-Fi CERTIFIED products. 

Wi-Fi Protected Setup 
Wi-Fi Protected Setup™ (previously called Wi-Fi Simple Config) is an optional 
certification program developed by the Wi-Fi alliance designed to ease set up of 
security enabled Wi-Fi networks in the home and small office environment. Wi-Fi 
Protected Setup supports methods (pushing a button or entering a PIN into a 
wizard-type application) that are familiar to most consumers to configure a 
network and enable security. 

Wireless Gateway 
Term used to differentiate between an access point and a more-capable device 
that can share an internet connection, serve DHCP, and bridge between wired 
and wireless networks. 

Wireless Network 
Devices connected to a network using a centralized wireless access point. 

WLAN 
Wireless Local Area Network. A type of local area network in which data is sent 
and received via high-frequency radio waves rather than cables or wires. 
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WPA 
Wi-Fi Protected Access is a data encryption specification for 802.11 wireless 
networks that replaces the weaker WEP. It improves on WEP by using dynamic 
keys, Extensible Authentication Protocol to secure network access, and an 
encryption method called Temporal Key Integrity Protocol (TKIP) to secure data 
transmissions. 

WPA2 
An enhanced version of WPA. It is the official 802.11i standard. It uses Advanced 
Encryption Standard instead of TKIP. AES supports 128-bit, 192-bit, and 256-bit 
encryption keys. 

Y 

Yagi Antenna 
An antenna type that radiates in only a specific direction. Yagi antennas are used 
in point-to-point situations. 
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5 Planning and Implementing Wireless 
Networks 

In This Chapter 

 Define the Application ...........................................................................57 

 Plan the Network ...................................................................................59 

 Perform Path Planning Studies .............................................................60 

ProSoft Technology provides various levels of technical support and application 
assistance to ensure the success of RadioLinx applications. Applications may 
vary in complexity, from a pair of radios communicating across a factory floor to 
hundreds of radios spread over a large metropolitan area. 

The following sections suggest typical questions for each area of concern and 
the support available from planning your communication network and order 
configuration to site review and verification. 
 Define the Application 
 Plan the Network 
 Perform Path Studies 
 Request a Quote 
 Install and Test the Network 

5.1 Define the Application 

How will the end devices communicate with each other? 
Industrial automation equipment uses a wide range of interfaces and protocols 
for communication. Some methods are easily adaptable to wireless, while others 
are difficult, and in a few cases, impossible to integrate wireless. 

Most Ethernet protocols (for example, Modbus TCP/IP, EtherNet IP) and serial 
protocols (for example, ASCII and RTU, DF1, DNP 3.0) adapt easily to wireless. 
Fieldbus interfaces (for example, PROFIBUS, HART, DeviceNet) and 
deterministic networks (for example, ControlNet) on the other hand are more 
difficult as they were typically not designed to support wireless communications. 

When designing wireless networks, it is important to review the interface and 
protocol options of the automation equipment and then choose the best approach 
for wireless networking. 
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What are the bandwidth and latency requirements? 
Bandwidth (data rate) and latency (delay time) are important considerations 
when designing a wireless network. There are many different factors that impact 
bandwidth and latency requirements including the application process, amount of 
I/O at each site, number of devices/sites sharing the network, interface/protocol, 
and if multimedia data types are used. 

For SCADA applications where RTUs are polled from a central PLC, bandwidth 
requirements are minimal and latency time can be hundreds of milliseconds (or 
longer) without impacting the process or usability of the system. 

This is because update times for SCADA systems are usually acceptable once 
every minute two. For this type of system, a relatively slow wireless network may 
suffice and be the best choice. However, if video data is also included across the 
wireless network, then data rate is very important as the video data requires 
much greater bandwidth. 

If wireless is used to transmit I/O, then how quickly does the program need to 
read/write to each point? Will the process suffer if the I/O is delayed? Will delays 
cause process errors in closed loop systems? Will safety or machine integrity be 
compromised if data is lost? If so, it may be better to use remote controllers 
(PLCs) for local I/O control and wireless network for exchanging data and 
commands. 

The bandwidth (data rate) and latency (packet delay) of the wireless network is a 
key consideration when choosing wireless technologies and wireless network 
design. 

Who will need access to the wireless network? 
Wireless networks are frequently used to connect workers to plant networks 
throughout a facility. These wireless local area networks (WLANs) create 
wireless "hotspots" for connecting laptops, PDAs, and other portable devices to 
the network. 

WLANs are commonly used by maintenance engineers to access automation 
programs and diagnostic tools when at the machine that failed. Other popular 
uses of WLANs include warehouse automation, process control, and production 
monitoring. 

When designing a wireless LAN for portable access, it is important to know 
where in the plant the works will need network access. It is also important to 
ensure that the WLAN and all portable devices support the same wireless RF 
and security standards. 

Does the Equipment Move? 
Another popular usage of industrial wireless is to communicate with controllers, 
HMIs, or I/O devices on moving equipment. Integrating wireless into systems that 
use overhead cranes, transfer cars, rotating platforms and automatic guided 
vehicles (AGVs) can reduce mechanical failures and improve production. 

When designing a wireless network for this type of application, it is important to 
consider where the devices will move for proper RF network coverage. 
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Will the equipment be relocated over time? 
For processes that move over time (such as mining operations) industrial 
wireless can save significant costs since cabling does not need to be re-installed 
every time the process moves. When designing a wireless network for this 
purpose, it is prudent to understand the long term plans for the process (where it 
will move) and design the wireless network accordingly. 

Are there any special regulations and environmental requirements? 
It is important to find out the local government regulations regarding RF use. The 
wireless network hardware must meet the RF and certification requirements of 
that country. This is specific to the country of installation and can impact 
frequency band, RF power output, and RF modulation methods. Local 
regulations may limit the performance of the wireless network. 

Also, some installation sites (such as oil and gas systems) require special 
certifications for installation in hazardous rate locations where explosive 
materials may be present. It is important to have proper approvals such as Class 
I, Division 2 or ATEX for these installations. 

Each site requires a power source to power the wireless modem. If power is not 
available (such as for a repeater site), then a battery with solar recharge may be 
required. 

Finally, review of environmental conditions of each site is necessary to ensure 
network reliability and hardware life. It is important to choose wireless equipment 
that meets the temperature requirements (often extreme at industrial sites) and 
protect the equipment from moisture and corrosive materials. 

5.2 Plan the Network 

Once the application is defined, the next step is to plan the network. This 
includes selecting the wireless technology, modem hardware, antenna types and 
antenna coax. 

What is the network topology? 
The simplest wireless topology is point-to-point where two sites are connected 
together for data exchange. 

For SCADA networks, the most common topology is point-to-multipoint where 
one master site communicates (and collects information) from multiple remote 
sites. 

Star Topologies are similar to point-to-multipoint topologies but permit 
communication between all sites, not just master to remote/remote to master. 
The most common example of a Star Topology is wireless networks for portable 
computer access where an access point in the center of the star. 
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Does my WLAN extend indoors and outdoors? 

Do PDAs, laptops, or other mobile and roaming devices need access? 

What are my security requirements? 

How many and how far away are my sites or users? 

Will I need to add a repeater site? 

Are there subnet requirements? 

What accessories are required and does the vendor supply these necessary components? 

5.3 Perform Path Planning Studies 

Path planning services is an essential part of an outdoor wireless solution 
providing an accurate account of items and budgetary costs required for the 
project. A Site Audit should be performed to collect GPS, obstruction, and 
existing structure data. This data supplies the RadioLinx Application Engineer 
pertinent information to provide a summary report for each site and path. The 
path planning report is generated indicating a complete radio bill of materials, 
antenna types, gain, height, tilt angle and location requirements, calculated fade 
margins, and a graphical path profile for each site and network topological terrain 
map. The report will also assist system integrators with initial design 
specifications for testing and verifying each path link. 

The following questions should be answered during path planning studies: 
 What tools are available to determine link quality? 
 How is path terrain visualized? 
 What are the Line-of-Sight (LoS) obstructions? 
 What types of antennas will be required? 
 How high will antennas need to be mounted and will an antenna mast or 

tower be required? 
 Are there antenna height restrictions? 

5.3.1 Sample Path Study 

A Path Study or Terrain Analysis is the initial step in the configuration of an RF 
network. It can be used for evaluation before an Onsite Survey is performed and 
can be considered as a proof of concept. A path study does not guarantee RF 
links. Man made objects such as buildings, towers and highways, trees and other 
foliage may not be displayed or calculated with the Path Study Report unless 
otherwise identified. These obstructions to RF line-of-site need to be considered 
during a site audit. Any obstructions within the RF path should be accounted for 
by providing the locations and height. The following information provides the user 
with recommended antenna height AGL and path profile of each site from the 
base location. Make sure antennas are above buildings, trees, foliage, and other 
obstructions. 
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If line-of-sight is not achieved, levels will be degraded. The Fresnel2 zone 
(shown in the following examples) requires freedom from any obstructions. 

5.3.2 Central Office M-Lower Mader Tank 
 

 Central Office Lower Mader Tank (M) 
Elevation (feet) 687.34 1007.21 
Latitude 34 17 09.00 N 34 17 03.00 
Longitude 118 48 47.00 W 118 47 08.00 W 
True Azimuth (degrees) 94.17 274.18 
Vertical Angle (degrees) 2.38 -2.39 
Antenna Model A2410NJ-DY A2414NJ-DY 
Antenna Height (feet) 18.00 45.00 
Antenna Gain (dBi) 10.00 14.00 
(dbm) 7.85 11.85 
TX Line Type C40M40-40-040 CVX540-40-100 
TX Line Length (feet) 40.0 100.0 
Tx Line Unit Loss (dB/100 feet) 6.70 2.20 
Tx Line Loss (dB) 2.68 2.20 
Connector Loss (dB) 0.40 0.40 
Miscellaneous Loss (dB) 1.50 1.50 
Frequency (MHz) 2400.0  
Polarization Vertical  
Path Length (mi) 1.58  
Free Space Loss (dB) 108.16  
Net Path Loss (dB) 92.84 92.84 
Radio Model RLX-IH RLX-IH 
Tx Power (Watts) 0.20 0.20 
(dBm) 23.00 23.00 
Effective Radiated Power 0.42 Watts 1.19 Watts 
(dBm) 6.27 30.75 
RX Sensitivity (µv) 11.21 11.21 
 Central Office Lower Mader Tank (M) 
(dBm) -86.00 -86.00 
RX Signal (µv) 71.99 71.99 
(dBm) -69.84 -69.84 
RX Field Strength (µv/m) 3012.58 1798.62 
Fade Margin (dB) 16.16 16.16 

Notes 

Line of Sight (LoS): Required for proper signal strength. Line of Sight means you 
can see the location at which you are trying to get an RF signal to. If the location 
is 5 miles or more, binoculars or a telescope can be used. 
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Fresnel Zone: An elliptic sphere between the two end points of the connections, 
which has to be free from obstructions. 

The sample report does not contain all path information for the sample network, 
however, additional graphs and path information are provided with 
recommendations for each network path with an actual RadioLinx Path Planning 
Report. 
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6 Physical Installation and Reliability Assurance 

It may be necessary for complex networks and paths with complicated terrains to 
visit each site for quality and reliability assurance. The site surveyor will measure 
radio reception for signal strength, background noise, packet errors, and data 
throughput. Completing the survey assures the customer and verifies the 
RadioLinx bill-of-material quotation and the networked system will operate with 
acceptable reliability. 
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7 Selecting Equipment 

In This Chapter 

 Determining the Required Gain .............................................................65 

 Calculate Total Gain..............................................................................66 

 Determining Gain Loss Due to Cabling .................................................67 

Selecting the proper equipment consists of: 
 Determining the Required Gain 
 Determining Gain Loss Due to Cabling 
 Calculating Total Gain 
 Making Your Selections 

7.1 Determining the Required Gain 

 Identify the unobstructed distance between RadioLinx antennas from the 
table. 

 Find the row that corresponds to the distance between the antennas. 
 Find the Link Gain in the appropriate row. The Net dB is based upon an 

antenna installed at a 16 foot (5 meters) height. 
 For example, if the unobstructed distance between RadioLinx devices is 5 

miles (8 km), the Net dB required is 19 dB. 
Net dB North America 

250mW 
Max. Distance 

Europe 
EIRP 100mW 
Max. Distance 

 Miles Kilometers Miles Kilometers 
4 2 3.2 1.4 2.3 
6 2.5 4 1.6 2.6 
9 3 4.8 2 3.2 
11 3.4 5.5 2.3 3.7 
13 3.4 5.5 2.5 4 
15 4.3 6.8 2.8 4.5 
17 4.8 7.7 3.2 5 
19 5.3 8.6 3.5 5.6 
22 6.3 10 4.2 6.8 
24 7.6 12 4.8 7.7 
26 8 12.8 5 8 
28 9 14.5 6 9.7 
30 10 16 6.7 10.8 
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Net dB North America 
250mW 
Max. Distance 

Europe 
EIRP 100mW 
Max. Distance 

 Miles Kilometers Miles Kilometers 
32 11.3 18 7.5 12 
35 13.4 21.5 9 14.5 
37 15 24 10 16 

Net dB is the gain of the antenna minus the cable loss. A 10 dB margin has been 
included in the above calculations. 
Wireless Path 
Distance 

60% Fresnel Zone Approximate Earth 
Curvature 

Antenna AGL Height 
with no Obstructions 

mi km feet m feet m feet m 
1 1.6 10 3 3 0.9 13 4 
5 8 30 9 5 1.5 35 10.7 
10 16 44 13 13 4 57 17 
15 24 55 16.7 28 8.5 83 25 
        

Additional antenna height will improve the maximum distance and will require a 
Path Feasibility Study to help determine a new height. A Path Study will better 
determine the appropriate antenna height and net dB gain required for a given 
path. Path Study and Site Survey services are available from ProSoft 
Technology. 

7.2 Calculate Total Gain 

The "Link Gain" is a composite of the gains of each of the antennas (the Master 
antenna and the Remote antenna) as well as any cable loss. For example, if you 
want to communicate over a 5 mile (8 km) unobstructed distance, you should 
include at least 19 dB of Link Gain. If you are using 4 feet of cable on the Master 
side and 10 feet of cable on the Remote side, you need to determine what the 
cable loss is by using the previous chart. 

Example: 
Cable loss at the Master: 2 dB (4ft, 1.22m) 
Cable loss at the Remote: 5 dB (10ft, 3.0m) 
Total Cable Loss: 7 dB 

You need 19dBi and you already know you will have 7dB gain loss due to 
cabling. In order to ensure that you have antennas that will cover the cable loss, 
the Required Gain must be added to the Cable Loss. 
Required gain for 5 miles (8 km): 19 dB 
Total cable loss: +7 dBi 
Required gain for antenna selection 26 dB 
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You can now select antennas based on the Calculated Gain Value of 26 dBi. The 
gain of each of your antennas must be equal to or greater than this value. 

More gain provides more distance. It makes no difference whether the gain is on 
the Master or the Remote antenna. The available gain is the sum of both 
antennas. Based on this, you could select an antenna at the Master site with a 
gain of 11 dBi and an antenna at the Remote site with a gain of 15 dBi totaling 26 
dBi. 

The calculation now looks like this: 
Gain Required: 19 dBi (5 mile (8km) distance) 
Master Antenna Gain: 11 dBi 
Remote Antenna Gain: 15 dBi 
Total Antenna Gain: 26 dBi 
Total Cable Loss: 7 dBi 
 

7.3 Determining Gain Loss Due to Cabling 

The length of the cable connecting an antenna to a RadioLinx modem or wireless 
Ethernet switch affects overall antenna gain. The following table shows 
approximate dB loss per 10 feet of cable. 
Cable Type dB Loss per 10 feet 
RG-316 4.2 
LMR195 1.8 
LMR400 0.67 
LMR600 0.44 
LMR1200 0.23 
LDF4 0.35 
LDF5 0.20 
LDF7 0.13 
VXL5 0.22 

Determine how much cable you will need by measuring the distance between 
where your RadioLinx modem or wireless Ethernet switch will be placed and the 
proposed location of the antenna in feet. 

Repeat this process for the remote RadioLinx modem or wireless Ethernet 
switch. 

Now use the previous chart to determine how much gain loss you will have to 
calculate when choosing your equipment. This will give you your Cable Gain 
Loss. 

Total Antenna Gain minus Total Cable Loss = Antenna Gain 

or 
26 dBi - 7 dBi = 19 dBi 

You can now choose equipment based on this information. 
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8 Antenna Selection Considerations 

In This Chapter 

 Understanding Antenna Attributes.........................................................69 

 Antenna Types ......................................................................................71 

 Considering The Signal Path (Line-of-Sight) .........................................73 

 Antenna Mounting Considerations ........................................................73 

 Considering Antenna Direction..............................................................74 

 

8.1 Understanding Antenna Attributes 

RadioLinx antennas come in a variety of types. All types are categorized by three 
important electrical characteristics: 
 Antenna Pattern 
 Antenna Gain 
 Antenna Polarity 

8.1.1 Antenna Pattern 

Information between two wireless devices is transferred via electromagnetic 
energy radiated by one antenna and received by another. The radiated power of 
most antennas is not uniform in all directions and has varying intensities. The 
radiated power in various directions is called the pattern of the antenna. Each 
antenna should be mounted so that its direction of strongest radiation intensity 
points toward the other antenna or antennas with which it will exchange signals. 

Complete antenna patterns are three-dimensional, although often only a two-
dimensional slice of the pattern is shown when all the antennas of interest are 
located in roughly the same horizontal plane, along the ground rather than above 
or below one another. 

A slice taken in a horizontal plane through the center (or looking down on the 
pattern) is called the azimuth pattern. A view from the side reveals a vertical 
plane slice called the elevation pattern. 

An antenna pattern with equal or nearly equal intensity in all directions is 
omnidirectional. In two dimensions, an omnidirectional pattern appears as a 
circle (in three dimensions, an omnidirectional antenna pattern would be a 
sphere, but no antenna has true omnidirectional pattern in three dimensions). An 
antenna is considered omnidirectional if one of its two dimensional patterns, 
either azimuth or elevation pattern, is omnidirectional. 
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Beam width is an angular measurement of how strongly the power is 
concentrated in a particular direction. Beam width is a three dimensional quantity 
but can be broken into two-dimensional slices just like the antenna pattern. The 
beam width of an omnidirectional pattern is 360 degrees because the power is 
equal in all directions. 

8.1.2 Antenna Polarity 

Antenna polarity refers to the direction that the electromagnetic field lines point 
as energy radiates away from the antenna. In general, antenna polarization is 
elliptical. The simplest and most common form of this elliptical polarization is 
simply a straight line, or linear polarization. Of the transmitted power that reaches 
a receiving antenna, only the portion that has the same polarization as the 
receiving antenna polarization is actually received. 

For example, if the transmit antenna polarization is linear pointed in the vertical 
direction (vertical polarization), and the receive antenna also has vertical 
polarization, the maximum amount of power possible will be received. On the 
other hand, if the transmit antenna has vertical polarization and the receive 
antenna has horizontal polarization, theoretically, no power would be received. If 
the two antennas have linear polarizations orientated at 45 degrees to each 
other, half of the possible maximum power will be received. 

8.1.3 Voltage Standing Wave Radio (VSWR) 

VSWR represents the degree with which an antenna is matched to the radio 
system impedance. Modern day antennas do not require tuning for optimum 
performance. VSWR is one of the easiest parameters to measure and VSWR 
meters are becoming very popular antenna installation tools. Most modern 
antennas, receivers, and transmitters are designed for peak performance when 
operating into a 50-Ohm transmission line. If the VSWR is too high, the 
transmitter power may be reduced as well as the strength of the received signal. 
The typical commercial standard for maximum allowable VSWR across the entire 
bandwidth of a system is 1.5:1. This means that the antenna impedance must be 
somewhere between 37.5 and 75 Ohms. A VSWR of 2:1 or greater is usually 
considered unacceptable (for receiving purposes only) since it increases losses 
in the transmission line. Incidentally, decreasing your VSWR below 1.5:1 will 
often be expensive and will have little noticeable performance improvement. You 
should specify the maximum VSWR and operating frequency bandwidth when 
specifying your antenna. 
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8.1.4 Antenna Gain 

Antenna gain is a measure of how strongly an antenna radiates in its direction of 
maximum radiation intensity, compared to how strong the radiation would be if 
the same power were distributed equally in all directions. An antenna's gain 
describes the distance to the furthest point on the pattern from the origin. For an 
omnidirectional pattern, the gain is 1 or equivalently 0 dB. The higher the 
antenna gain, the narrower the beam width, and vice versa. The amount of 
power that is received by the receiving antenna is proportioned to: 

(transmitter power) x (transmit antenna gain) 
x (receive antenna gain) 

The antenna gain and transmit power can therefore be traded off. For example, 
doubling ones antenna gain has the same effect as doubling the transmitter's 
power. Doubling both antenna gains has the same effect as quadrupling the 
transmitter's power. 

8.2 Antenna Types 

There are various types of antennas available for RadioLinx radios but all 
basically fall into one of two categories; omnidirectional and directional (see 
Antenna Patterns). 

In a nutshell, omnidirectional antennas are used when signals need to link to 
multiple sites, whereas, a directional antenna are used to link to a single site. In 
addition, gain and distance determine what antenna type should be used. 

8.2.1 Collinear Array Antenna 

This antenna is typically composed of several linear antennas (like the 1/2 wave 
whip) stacked on top of each other. The more stacked elements within the 
collinear array, the longer the antenna and the more gain it has. 

The following types of antennas are available from ProSoft Technology: 
 2dBi Multi-band Swivel Antenna 2.4/5 GHz 
 2.4 GHz Base Station Antenna (4 dBi, 6 dBi, and 8 dBi) 
 2.4 GHz Heavy Duty Antenna (6 dBi and 9 dBi) 
 2.4 GHz Panel/Patch Antenna (8 dBi, 13 dBi, and 19 dBi) 
 2.4 GHz Parabolic Antenna (19 dBi and 24 dBi) 
 2.4 GHz Straight Antenna (2 dBi and 5dBi) 
 2.4 GHz Whipless Antenna (3 dBi) 
 2.4 GHz Yagi Antenna (10 dBi and 15 dBi) 
 2.4 GHz Magnetic Mount Antenna (5 dBi) 
 2.4 GHz Omni Base Station Antenna (15 dBi) 
 2.4 GHz Halfwave Antenna (2 dBi) 
 5 GHz Base Station Antenna (12 dBi) 
 5 GHz Heavy Duty Antenna (6 dBi and 9 dBi) 
 5 GHz Panel/Patch Antenna (19 dBi and 24 dBi) 
 5 GHz Parabolic Antenna (26 dBi and 29 dBi) 
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The antenna pattern is toroidal; its azimuth beam width is 360° (omnidirectional); 
its vertical beam width depends on its length (the number of stacked elements), 
such that more elements produce a narrower beam width. 

The antenna gain, typically 5 to 10 dBi, also depends on the length (number of 
stacked elements), such that more elements produce a higher gain. 

The antenna polarity is linear, parallel to the length of the antenna. 

8.2.2 Yagi Array Antenna 

A Yagi antenna is composed of an array of linear elements, parallel to one 
another and attached perpendicular to and along the length of a metal boom. The 
feed is attached to only one of the elements. Elements on one side of the feed 
element are longer and act as reflectors. Elements on the other side are shorter 
and act as directors. This causes the antenna to radiate in a beam out the end 
with the shorter elements. The actual pattern depends on the overall geometry, 
including the number of elements, element spacing, element length, and so on. 
In some cases, the antenna is enclosed in a protective tube that hides the actual 
antenna geometry. 

8.2.3 1/2 Straight Whip or 1/2 Articulating Whip 

This is the most commonly used antenna type and does not require a ground 
plane. These antennas are about 5 inches long and is typically connected to a 
remote radio (directly to the enclosure). 

The antenna pattern is a beam pointed along the boom toward the end with the 
shorter elements. The beam width varies with antenna geometry but generally is 
proportional to the length (where longer length produces a narrower beam). 

The antenna gain, typically 6 to 15 dBi, also varies with antenna geometry, but is 
generally proportional to the length (where longer length produces higher gain). 
The antenna polarity is linear (parallel to the elements, perpendicular to the 
boom). 

An articulating antenna bends at the connection and functions the same as a 
non-articulating antenna. 

8.2.4 1/4 Whip Antenna 

This antenna is about 2.5 inches long and does require a ground plane mounting 
below the antenna and over the top surface of the radio. The 1/4 whip works well 
with belt mounted radios but does not radiate well out the top of the antenna. 
Because of this, it must remain vertical. 
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8.2.5 Parabolic Reflector Antenna 

A parabolic reflector antenna consists of a parabolic shaped dish and a feed 
antenna located in the front of the dish. Power is radiated from the feed antenna 
toward the reflector. Due to the parabolic shape, the reflector concentrates the 
radiation into a narrow pattern, producing a high-gain beam. 

8.3 Considering The Signal Path (Line-of-Sight) 

Obstructions that block the signal path can greatly deflate the radio carrier 
because of the frequency range used in operation. The only way to ensure 
constant, solid communications is to make sure that the antennas are actually 
visible to each other. For line-of-sight, you should be able to visibly see the 
remote location’s antenna from the main site. Longer distances may require the 
use of binoculars. There should be no obstructions between the antennas. This 
includes trees, buildings, hills, and so on. Checking for direct visibility is best 
addressed using survey laser equipment or a Site Survey Kit. 

When considering the path, also consider whether the RadioLinx Master talks 
with multiple RadioLinx Remotes. Antennas achieve gain by focusing the beam 
of energy. If the beam is focused, the antenna cannot communicate as well in all 
directions. Therefore, if a RadioLinx Master needs to communicate with multiple 
RadioLinx Remotes, an antenna will have to be selected that has a pattern that 
can see all RadioLinx Remotes. 

The antenna pattern is a beam pointed away from the concave side of the dish 
(beam width varies with the size of the reflector and the antenna construction). 

The antenna gain varies with the size of the reflector and the antenna 
construction. Typical values are 15 to 30 dBi. 

The antenna polarity depends on the feed antenna polarization. 

8.4 Antenna Mounting Considerations 

Not only is the relationship between the antenna and the earth improved by 
mounting the antenna higher (resulting in a better range), but the probability of 
interrupting the line-of-sight is reduced. 

Avoid mounting next to solid objects (walls, buildings, towers, or girders). The 
resulting reflected radio energy causes drastically reduced efficiency. A minimum 
of six feet is a good general rule to avoid reflection. 

Not only do you want to stay away from sources of electric noise (power lines, 
electrical motors, solenoids, high power radio sources, or any high voltage power 
usage), but you want to avoid the possibility of electrical shock which can be 
fatal. 
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8.5 Considering Antenna Direction 

In order to have gain, a Yagi or Parabolic antenna takes its signal strength from 
all around and points it in one general direction. This makes the Yagi or Parabolic 
"Directional". This means that is must be orientated one particular way so the 
radio signal is pointed toward the antenna of the device with which you want to 
communicate. 

The omni antenna is designed to be usable from any direction (hence the name). 
As a result, it doesn't have the straight-line range of the Yagi. Because the omni 
distributes its radio energy in more of a donut shape, be sure that the main part is 
oriented straight up and down, with the feed line at the bottom. In the base, there 
are four angled wires called "ground radials" which should be rotated until they 
are angled downward for best efficiency. 



Lightning Protection PSW-PWD ♦ ProSoft Software 
User Manual ProSoft Wireless Designer 

 

 
ProSoft Technology, Inc. Page 75 of 91 
July 8, 2009 
 

9 Lightning Protection 

In This Chapter 
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Antenna manufacturers are often asked about lightning and whether their 
antenna is lightning proof. This is not a simple question to answer. In this 
application note we will attempt to describe some of the statistical properties of 
lightning strikes and give some recommendations on how to best protect your 
installation from damage due to a lightning strike. 

It is important to point out at the start that lightning protection is primarily a 
function of how much time and money you are willing to spend. Obviously, the 
more expensive the radio and the importance of system connectivity, the more 
robust your protection should be. 
 

9.1 An Introduction to Lightning 

Lightning has been around since the beginning of time. In fact, at this very 
moment, lightning is striking somewhere on the earth. In the lower 48 US states 
and Canada, lightning is most prevalent in Florida (with an average of 70 to 100 
storm days per year!) and the Rocky Mountains especially in the Colorado area 
(with an average of 70 storm days per year). In California and the Northern parts 
of the USA and Canada the likelihood of encountering lightning diminishes to 
about 10 to 30 storm days per year. Lightning is most common starting in the 
spring and ending in the fall with a large peak in the summer but it can occur at 
any time of the year. 
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9.2 The Nature of Lightning 

Lightning can form and stay in the upper atmosphere. This is often a beautiful 
sight to behold as the bolts jump from cloud to cloud. On the other hand, when 
lightning leaves the clouds and strikes the ground or a tall object, it can inflict 
instant destruction and even death to those unfortunate to be near the strike. 

The energy present in a lightning bolt can be considerable and a direct hit will 
inflict the maximum damage. It is estimated that a typical bolt may contain a 
potential of millions (1,000,000’s) of volts thus generating currents up to 100,000 
amperes! That is very destructive energy. At the same time, the heat in the bolt 
can have a temperature up to 30,000 K, hot enough to start fires. 

A lightning bolt will often drag or jump along the ground. Therefore, there can be 
considerable damage in a wide area (even hundred’s of feet) surrounding the 
strike. Just ask a dairy farmer what happened to his cows that tried to hide 
beneath a tree that had a direct lightning strike. 

9.3 Lightning Protection in General 

Lightning protection must be examined from four distinct directions. First off, the 
place where the antenna is mounted (such as on a tower) is important. Then 
there must be input protection from the lightning strike itself, typically in the form 
of a huge and rapid build up of voltage and current at the input to the radio. 
Thirdly, a proper ground system must be employed to rapidly conduct the 
lightning bolt energy away from the radio. Finally, protection is required at the 
output or main power supply such as the line voltage supply (for example, the 
115 VAC we obtain from a line cord). Let’s discuss each of them separately. 

9.4 Antenna Mounting 

It is well known that lightning statistically strikes the highest electrical conductor 
in an area and then follows the lowest resistance and shortest path to ground. 
Because antennas are usually mounted in high places, they are very susceptible 
to lightning strikes. Most antennas have a metallic boom and the elements are 
often attached directly to the boom so they are a likely target for a lightning strike. 

Therefore, the antenna location and how it is mounted is probably the most 
controversial topic when any discussion of lightning occurs. Ben Franklin gave 
rise to the theory that the lightning was electricity and found this out when he 
almost was killed by a lightning strike conducted down the wire holding down his 
kite. Franklin is sometimes credited with the ball discharger and the pointed rods 
on houses. As a result, to this day lightning rods with grounding wires are a part 
of folk law and many are installed on high buildings and homes, especially in 
areas prone to lightning activity. Properly installed and grounded, these devices 
surely do work. 
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Nowadays, new controversy has resulted with the use of spline balls, static 
dischargers and wicks mounted on antennas and the top of towers. These 
devices are said to provide a constant discharge thus decreasing the potential for 
a direct strike. Some users claim a diminished amount of direct hits after 
installing these devices. 

Suffice it to say, if at all possible, do not mount your antenna on the highest 
building or tower. Place it a few feet lower and hopefully the fickle lightning bolt, if 
it generates a direct hit, will not discharge through the antenna. Furthermore, the 
boom or mast should be grounded to the mast or tower. More on this shortly. Do 
not forget to ground guy wires that are used on stabilize towers. They are just as 
likely to be hit because they extend over a wide area around the tower. 

9.5 Input Protection 

Input protection is typically provided by a lightning or surge protector at the input 
(or antenna side) of a radio. There are three major types of lightning protection 
devices for the radio input. They are the spark gap, the gas discharge tube and 
the quarter-wavelength (1/4) wavelength shorted stub. Each method has its 
pluses and minuses. 

The spark gap is the oldest know lightning protection having probably been 
invented by Ben Franklin! Basically it consists of two balls or points closely 
spaced and directly across the transmission line. When a strike occurs, the high 
voltage present will jump across the points and be conducted to ground. RF 
transmission devices for 50 Ohm systems such as this have been around since 
the 1950’s. 

The shortcoming with this older device is that it may not protect against a weak 
or lower voltage strike. Adjustment at the factory may produce varying voltage 
breakdowns. Furthermore, once a strike is taken, the device may fail or short 
circuit so maintenance is required. 

A more recently developed input protection device is the gas tube. It works in a 
similar manner to the spark gap but can be designed to operate reliably at much 
lower voltages down to 100 Volts for low power circuits and 250 Volts or higher 
for higher power applications. Another advantage is device is that it can be 
designed to operate over a very broadband frequency range with low VSWR up 
to about 2 GHz. However, it too must be replaced after a strike although it will not 
necessarily warn the user by going to a short circuit so preventative maintenance 
is required. 

The quarter wavelength shorting stub is becoming a very popular device, 
especially above 800 MHz where system bandwidth is generally narrow. It 
consists of a tuned quarter wavelength shorted coaxial type transmission line that 
is placed directly across the transmission line. Simple types have a narrow 
bandwidth, typically 10'-. bandwidth, but are low loss and inexpensive. 
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The optimum place to locate an input protector is at the entry point to the building 
where the equipment is located. Do not forget to provide a low impedance 
ground connection to the protector as described below. Always try to keep 
the lightning and the protection devices outdoors wherever possible! 

9.6 Grounding 

The most important lightning protection is a good low impedance Earth/ground 
connection to the associated equipment. The Earth ground connection should be 
a copper plated rod preferably at least 5 to 8 feet in length driven into the ground. 
This ground rod should be located as close to the equipment as possible, 
typically just outside of a building at the entry point of the antenna feedlines. 

Greater protection can be provided by using additional ground rods spaced at 
least 8 feet from and connected to the original rod. Substituting plumbing, power 
ground return and other "so called" grounds for a ground rod is definitely not 
recommended. 

Finally, there should be a large diameter (#4 AWG or larger) copper wire 
connecting the equipment to the Earth ground. The shorter the wire, the better. 
Additional information on grounding can be found in Reference 1. 

9.7 Mains and Power Supply Protection 

Just because your radio and antenna are miles away from a lightning strike does 
not mean that you are protected. Lightning often strikes power lines and 
produces a large voltage surge or spike that can be transmitted for miles on the 
main power lines. 

Therefore, for maximum protection, all power line interfaces should include a 
transient voltage surge protector. These devices are becoming quite common 
and inexpensive. Again, there are simple protectors and those that may include 
additional protection with built-in line inductors. Just make sure that the surge 
protector is placed between the power lines and the equipment power supply. 

9.8 Summary 

As stated at the beginning of this paper, lightning damage can be extensive and 
costly. We have tried to provide you with an overview of things to consider when 
installing a radio and antenna system but only you can determine how much 
protection is required. Astron Antennas Co. has access to various lightning 
protection solutions for most applications. Please call for additional information 
on lightning protection devices and how they can help protect your investment. 

References: 
1. "The "Grounds" for Lightning and EMP Protection", by Roger Block, published 
by PolyPhaser Corporation. 
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10 Basic Principles 
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Most of the information needed to help you use  is provided in a Help System 
that is always available whenever you are running . The Help System does not 
require an Internet connection. 

To view the help pages, start , open the HELP menu, and then choose CONTENTS. 
 

10.1 Using the Help System 

Most of the information needed to help you use  is provided in a Help System 
that is always available whenever you are running . The Help System does not 
require an Internet connection. 

To view the help pages, start , open the HELP menu, and then choose CONTENTS. 

10.2 Tool Tips 

A Tool Tip is a small help window that pops up when you rest the mouse pointer 
over a button, an icon, a menu command, or a part of a window that is "sensitive" 
to the mouse. Tool Tips provide a brief description of the button or icon’s 
purpose. 

Many parts of the  window provide Tool Tips. These can be very useful to help 
you with buttons or commands that you do not use very often. 

10.3 Review of Windows mouse and keyboard controls 

The Microsoft Windows operating system, and most Windows compatible 
applications, including the PSW-PWD, use the computer keyboard and mouse in 
a standard way. This makes it easier for computer users to learn to use new 
applications quickly. 
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The computer you use in the field may be a desktop PC or a laptop PC. Desktop 
PCs typically have a keyboard and mouse (pointing device) connected to the 
computer by cables, or sometimes by a wireless link. Laptop PCs have a built-in 
keyboard and often have a built-in pointing device such as a touch pad or a 
trackball. Most laptops also allow you to connect a standard computer mouse if 
you prefer it to the built-in pointing device. 

10.4 Using the Mouse 

As you move the mouse around on your desk, you will see an arrow (or other 
shape) moving around on the computer screen. You use the mouse or pointing 
device to "point" to a menu, a button, or a data item on the screen. In the PSW-
PWD, you click and release the mouse buttons (left and right) to select a menu 
item, to push a button on the screen, to select one or more data items, or to open 
a "shortcut" menu. 

Most people will click the left mouse button with the right index finger, and the 
right mouse button with the right middle finger. You can use the Windows Control 
Panel to reverse the operation of the mouse buttons, for example if you prefer to 
use your left hand to operate the mouse rather than your right hand. In this 
training manual, however, we will refer to the left mouse button and right mouse 
button as if you are using your right hand on the mouse. 

The left and right mouse buttons have different functions in the PSW-PWD. 
 Use the left mouse button to select a menu item, click a button or select one 

or more data items. 
 Use the right mouse button to open a "shortcut" menu with commands that 

are useful for the item or area of the screen where the mouse pointer is 
currently resting. 

 Some commands require a double-click before the command is recognized. 
"Double-click" means quickly pressing and releasing the left mouse button 
twice. 

Use double-click to: 
 Open a file or run a program on your computer’s "desktop" area. 
 Open and close a folder in the PSW-PWD Tree View window. 

10.5 Using the Keyboard 

Most of the time, you will be using the keyboard to add or edit data items after 
you have selected and opened them with the mouse. As a timesaver, however, 
you can also use the keyboard to do most of the same things you can do with the 
mouse. 

Some useful keyboard shortcuts include: 
 Windows System Key Combinations (page 81) 
 Dialog Box Commands (page 81) 
 Windows Program Key Combinations (page 81) 
 General Keyboard-Only Commands (page 82) 
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10.5.1 Windows System Key Combinations 
 

Key Action 
F1 Help 
ALT+TAB Switch between open programs 
ALT+F4 Quit program 
SHIFT+DELETE Delete item permanently 
 

10.5.2 Dialog Box Commands 
 

Key Action 
TAB Move to the next control in the dialog box 
SHIFT+TAB Move to the previous control in the dialog box 
SPACEBAR If the current control is a button, this clicks the button. If the 

current control is a check box, this toggles the check box. If the 
current control is an option, this selects the option. 

ENTER Equivalent to clicking the selected button (the button with the 
outline) 

ESC Equivalent to clicking the Cancel button 
ALT+ underlined letter in dialog 
box item  

Move to the corresponding item 

 

10.5.3 Windows Program Key Combinations 
 

Key Action 
CTRL+C Copy 
CTRL+X Cut 
CTRL+V Paste 
CTRL+Z Undo 
 

10.5.4 The  Help System 

The ProSoft Wireless Designer has a help system that works like a web browser. 
Each dialog box has its own page in the help system, which explains each item 
on the dialog box. The help system does not require an internet connection.  

To open a help window, use the mouse to click the Help button, near the lower 
right corner of most dialog boxes, or press the F1 key on your keyboard. 

Many help pages have links that lead you to more information if you need it. 
Links are always underlined. Use your mouse to click the underlined text to 
"follow a link" and open a help page with more information. 

You can use the Search button to search for words or phrases inside a help file. 
The help system shows you a list of help topics that contain the words you typed 
in the Search field. Click a topic from the list to view the help page. 

You can also use the Index button to see an index of keywords. You can type the 
first few letters of a keyword to jump directly to the part of the index you would 
like to view. Each keyword is linked to one or more help topics. Click a keyword 
to see a list of topics, and then click a topic from the list to view the help page. 
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10.5.5 General Keyboard-Only Commands 
 

Key Action 
F1 Starts Windows Help 
F10 Activates menu bar options 
SHIFT+F10  Opens a shortcut menu for the selected item (this is the same 

as right-clicking an object 
ALT+DOWN ARROW Opens a dropdown list box 
ALT+TAB Switch to another running program (hold down the ALT key and 

then press the TAB key to view the task-switching window) 
ALT+SPACE Displays the main window’s System menu (from the System 

menu, you can restore, move, resize, minimize, maximize, or 
close the window) 

ALT+ underlined letter in menu  Opens the menu 
ALT+F4 Closes the current window 
 

10.5.6 Keyboard Shortcuts 

Network Diagram View 
Action Command 
Delete selection Del 
Select all items Ctrl-A 
Duplicate selection Ctrl-D 
Copy selection Ctrl-C, Ctrl-Ins 
Paste from clipboard Ctrl-V, Shift-Ins 
Cut selection Ctrl-X 
Undo last action Ctrl-Z 
Redo an action that was undone Ctrl-Shift-Z, Ctrl-Y 
Open properties dialog of selected items Enter 
Nudge selection Arrow keys 

Application shortcuts 
Action Command 
New document Ctrl-N 
Open document Ctrl-O 
Save document Ctrl-S 
Print document Ctrl-P 
Close document Ctrl-Q 
Select pick tool Ctrl-1 
Select site tool Ctrl-2 
Select link tool Ctrl-3 
Close application Alt-F4 
Context sensitive help F1 
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11 Support, Service & Warranty 

In This Chapter 

 How to Contact Us: Technical Support..................................................83 

 Return Material Authorization (RMA) Policies and Conditions...............84 

 LIMITED WARRANTY...........................................................................85 

ProSoft Technology, Inc. (ProSoft) is committed to providing the most efficient 
and effective support possible. Before calling, please gather the following 
information to assist in expediting this process: 

1 Product Version Number 
2 System architecture 
3 Network details 

If the issue is hardware related, we will also need information regarding: 

1 Module configuration and contents of file 
o Module Operation 
o Configuration/Debug status information 
o LED patterns 

2 Information about the processor and user data files as viewed through and 
LED patterns on the processor. 

3 Details about the serial devices interfaced, if any. 

11.1 How to Contact Us: Technical Support 
Internet Web Site: www.prosoft-technology.com/support 

E-mail address: support@prosoft-technology.com 
Asia Pacific 
+603.7724.2080, support.asia@prosoft-technology.com 
Languages spoken include: Chinese, English 
Europe (location in Toulouse, France) 
+33 (0) 5.34.36.87.20, support.EMEA@prosoft-technology.com 
Languages spoken include: French, English 
North America/Latin America (excluding Brasil) (location in California) 
+1.661.716.5100, support@prosoft-technology.com 
Languages spoken include: English, Spanish 
For technical support calls within the United States, an after-hours answering system allows pager 
access to one of our qualified technical and/or application support engineers at any time to answer 
your questions. 
Brasil (location in Sao Paulo) 
+55-11-5084-5178, eduardo@prosoft-technology.com 
Languages spoken include: Portuguese, English 
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11.2 Return Material Authorization (RMA) Policies and Conditions 

The following RMA Policies and Conditions (collectively, "RMA Policies") apply to 
any returned Product. These RMA Policies are subject to change by ProSoft 
without notice. For warranty information, see "Limited Warranty". In the event of 
any inconsistency between the RMA Policies and the Warranty, the Warranty 
shall govern.  

11.2.1 All Product Returns: 

a) In order to return a Product for repair, exchange or otherwise, the 
Customer must obtain a Returned Material Authorization (RMA) number 
from ProSoft and comply with ProSoft shipping instructions. 

b) In the event that the Customer experiences a problem with the Product for 
any reason, Customer should contact ProSoft Technical Support at one of 
the telephone numbers listed above (page 83). A Technical Support 
Engineer will request that you perform several tests in an attempt to 
isolate the problem. If after completing these tests, the Product is found to 
be the source of the problem, we will issue an RMA. 

c) All returned Products must be shipped freight prepaid, in the original 
shipping container or equivalent, to the location specified by ProSoft, and 
be accompanied by proof of purchase and receipt date. The RMA number 
is to be prominently marked on the outside of the shipping box. Customer 
agrees to insure the Product or assume the risk of loss or damage in 
transit. Products shipped to ProSoft using a shipment method other than 
that specified by ProSoft or shipped without an RMA number will be 
returned to the Customer, freight collect. Contact ProSoft Technical 
Support for further information. 

d) A 10% restocking fee applies to all warranty credit returns whereby a 
Customer has an application change, ordered too many, does not need, 
and so on. 

11.2.2 Procedures for Return of Units Under Warranty: 

A Technical Support Engineer must approve the return of Product under 
ProSoft’s Warranty: 

a) A replacement module will be shipped and invoiced. A purchase order will 
be required. 

b) Credit for a product under warranty will be issued upon receipt of 
authorized product by ProSoft at designated location referenced on the 
Return Material Authorization. 

11.2.3 Procedures for Return of Units Out of Warranty: 

a) Customer sends unit in for evaluation 
b) If no defect is found, Customer will be charged the equivalent of $100 

USD, plus freight charges, duties and taxes as applicable. A new 
purchase order will be required. 
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c) If unit is repaired, charge to Customer will be 30% of current list price 
(USD) plus freight charges, duties and taxes as applicable. A new 
purchase order will be required or authorization to use the purchase order 
submitted for evaluation fee.  

The following is a list of non-repairable units: 
o 3150 - All 
o 3750 
o 3600 - All 
o 3700 
o 3170 - All 
o 3250 
o 1560 - Can be repaired, only if defect is the power supply 
o 1550 - Can be repaired, only if defect is the power supply 
o 3350 
o 3300 
o 1500 - All 

11.3 LIMITED WARRANTY 

This Limited Warranty ("Warranty") governs all sales of hardware, software and 
other products (collectively, "Product") manufactured and/or offered for sale by 
ProSoft, and all related services provided by ProSoft, including maintenance, 
repair, warranty exchange, and service programs (collectively, "Services"). By 
purchasing or using the Product or Services, the individual or entity purchasing or 
using the Product or Services ("Customer") agrees to all of the terms and 
provisions (collectively, the "Terms") of this Limited Warranty. All sales of 
software or other intellectual property are, in addition, subject to any license 
agreement accompanying such software or other intellectual property. 

11.3.1 What Is Covered By This Warranty 

a) Warranty On New Products: ProSoft warrants, to the original purchaser, 
that the Product that is the subject of the sale will (1) conform to and 
perform in accordance with published specifications prepared, approved 
and issued by ProSoft, and (2) will be free from defects in material or 
workmanship; provided these warranties only cover Product that is sold as 
new. This Warranty expires three years from the date of shipment (the 
"Warranty Period"). If the Customer discovers within the Warranty Period 
a failure of the Product to conform to specifications, or a defect in material 
or workmanship of the Product, the Customer must promptly notify 
ProSoft by fax, email or telephone. In no event may that notification be 
received by ProSoft later than 39 months. Within a reasonable time after 
notification, ProSoft will correct any failure of the Product to conform to 
specifications or any defect in material or workmanship of the Product, 
with either new or used replacement parts. Such repair, including both 
parts and labor, will be performed at ProSoft’s expense. All warranty 
service will be performed at service centers designated by ProSoft. 
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b) Warranty On Services: Materials and labor performed by ProSoft to repair 
a verified malfunction or defect are warranteed in the terms specified 
above for new Product, provided said warranty will be for the period 
remaining on the original new equipment warranty or, if the original 
warranty is no longer in effect, for a period of 90 days from the date of 
repair. 

11.3.2 What Is Not Covered By This Warranty 

a) ProSoft makes no representation or warranty, expressed or implied, that 
the operation of software purchased from ProSoft will be uninterrupted or 
error free or that the functions contained in the software will meet or 
satisfy the purchaser’s intended use or requirements; the Customer 
assumes complete responsibility for decisions made or actions taken 
based on information obtained using ProSoft software. 

b) This Warranty does not cover the failure of the Product to perform 
specified functions, or any other non-conformance, defects, losses or 
damages caused by or attributable to any of the following: (i) shipping; (ii) 
improper installation or other failure of Customer to adhere to ProSoft’s 
specifications or instructions; (iii) unauthorized repair or maintenance; (iv) 
attachments, equipment, options, parts, software, or user-created 
programming (including, but not limited to, programs developed with any 
IEC 61131-3, "C" or any variant of "C" programming languages) not 
furnished by ProSoft; (v) use of the Product for purposes other than those 
for which it was designed; (vi) any other abuse, misapplication, neglect or 
misuse by the Customer; (vii) accident, improper testing or causes 
external to the Product such as, but not limited to, exposure to extremes 
of temperature or humidity, power failure or power surges; or (viii) 
disasters such as fire, flood, earthquake, wind and lightning. 

c) The information in this Agreement is subject to change without notice. 
ProSoft shall not be liable for technical or editorial errors or omissions 
made herein; nor for incidental or consequential damages resulting from 
the furnishing, performance or use of this material. The user guide 
included with your original product purchase from ProSoft contains 
information protected by copyright. No part of the guide may be duplicated 
or reproduced in any form without prior written consent from ProSoft. 

11.3.3 Disclaimer Regarding High Risk Activities 

Product manufactured or supplied by ProSoft is not fault tolerant and is not 
designed, manufactured or intended for use in hazardous environments requiring 
fail-safe performance including and without limitation: the operation of nuclear 
facilities, aircraft navigation of communication systems, air traffic control, direct 
life support machines or weapons systems in which the failure of the product 
could lead directly or indirectly to death, personal injury or severe physical or 
environmental damage (collectively, "high risk activities"). ProSoft specifically 
disclaims any express or implied warranty of fitness for high risk activities. 
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11.3.4 Intellectual Property Indemnity 

Buyer shall indemnify and hold harmless ProSoft and its employees from and 
against all liabilities, losses, claims, costs and expenses (including attorney’s 
fees and expenses) related to any claim, investigation, litigation or proceeding 
(whether or not ProSoft is a party) which arises or is alleged to arise from Buyer’s 
acts or omissions under these Terms or in any way with respect to the Products. 
Without limiting the foregoing, Buyer (at its own expense) shall indemnify and 
hold harmless ProSoft and defend or settle any action brought against such 
Companies to the extent based on a claim that any Product made to Buyer 
specifications infringed intellectual property rights of another party. ProSoft 
makes no warranty that the product is or will be delivered free of any person’s 
claiming of patent, trademark, or similar infringement. The Buyer assumes all 
risks (including the risk of suit) that the product or any use of the product will 
infringe existing or subsequently issued patents, trademarks, or copyrights. 

a) Any documentation included with Product purchased from ProSoft is 
protected by copyright and may not be duplicated or reproduced in any 
form without prior written consent from ProSoft. 

b) ProSoft’s technical specifications and documentation that are included 
with the Product are subject to editing and modification without notice. 

c) Transfer of title shall not operate to convey to Customer any right to make, 
or have made, any Product supplied by ProSoft. 

d) Customer is granted no right or license to use any software or other 
intellectual property in any manner or for any purpose not expressly 
permitted by any license agreement accompanying such software or other 
intellectual property. 

e) Customer agrees that it shall not, and shall not authorize others to, copy 
software provided by ProSoft (except as expressly permitted in any 
license agreement accompanying such software); transfer software to a 
third party separately from the Product; modify, alter, translate, decode, 
decompile, disassemble, reverse-engineer or otherwise attempt to derive 
the source code of the software or create derivative works based on the 
software; export the software or underlying technology in contravention of 
applicable US and international export laws and regulations; or use the 
software other than as authorized in connection with use of Product. 

f) Additional Restrictions Relating To Software And Other Intellectual 
Property 

In addition to compliance with the Terms of this Warranty, Customers 
purchasing software or other intellectual property shall comply with any 
license agreement accompanying such software or other intellectual 
property. Failure to do so may void this Warranty with respect to such 
software and/or other intellectual property. 

11.3.5 Disclaimer of all Other Warranties 

The Warranty set forth in What Is Covered By This Warranty (page 85) are in lieu 
of all other warranties, express or implied, including but not limited to the implied 
warranties of merchantability and fitness for a particular purpose. 
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11.3.6 Limitation of Remedies ** 

In no event will ProSoft or its Dealer be liable for any special, incidental or 
consequential damages based on breach of warranty, breach of contract, 
negligence, strict tort or any other legal theory. Damages that ProSoft or its 
Dealer will not be responsible for included, but are not limited to: Loss of profits; 
loss of savings or revenue; loss of use of the product or any associated 
equipment; loss of data; cost of capital; cost of any substitute equipment, 
facilities, or services; downtime; the claims of third parties including, customers of 
the Purchaser; and, injury to property. 

** Some areas do not allow time limitations on an implied warranty, or allow the exclusion or 
limitation of incidental or consequential damages. In such areas, the above limitations may not 
apply. This Warranty gives you specific legal rights, and you may also have other rights which vary 
from place to place. 

11.3.7 Time Limit for Bringing Suit 

Any action for breach of warranty must be commenced within 39 months 
following shipment of the Product. 

11.3.8 No Other Warranties 

Unless modified in writing and signed by both parties, this Warranty is 
understood to be the complete and exclusive agreement between the parties, 
suspending all oral or written prior agreements and all other communications 
between the parties relating to the subject matter of this Warranty, including 
statements made by salesperson. No employee of ProSoft or any other party is 
authorized to make any warranty in addition to those made in this Warranty. The 
Customer is warned, therefore, to check this Warranty carefully to see that it 
correctly reflects those terms that are important to the Customer. 

11.3.9 Allocation of Risks 

This Warranty allocates the risk of product failure between ProSoft and the 
Customer. This allocation is recognized by both parties and is reflected in the 
price of the goods. The Customer acknowledges that it has read this Warranty, 
understands it, and is bound by its Terms. 

11.3.10 Controlling Law and Severability 

This Warranty shall be governed by and construed in accordance with the laws of 
the United States and the domestic laws of the State of California, without 
reference to its conflicts of law provisions. If for any reason a court of competent 
jurisdiction finds any provisions of this Warranty, or a portion thereof, to be 
unenforceable, that provision shall be enforced to the maximum extent 
permissible and the remainder of this Warranty shall remain in full force and 
effect. Any cause of action with respect to the Product or Services must be 
instituted in a court of competent jurisdiction in the State of California. 
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